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1. Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.
The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.
No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microﬁlm or any other means
without prior written permission from Esko Software BV.
This document supersedes all previous dated versions.
®

PANTONE Colors displayed in the software application or in the user documentation may not match
PANTONE-identiﬁed
standards. Consult current PANTONE Color Publications for accurate color.
®
PANTONE and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015
Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.
This software is based in part on the work of the Independent JPEG Group.
Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.
Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.
Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.
Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.
Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.
Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.
This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).
Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.
SolidWorks is a registered trademark of SolidWorks Corporation.
Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.
The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.
Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.
Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.
Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.
Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.
All other product names are trademarks or registered trademarks of their respective owners.
Correspondence regarding this publication should be forwarded to:
Esko Software BV
Kortrksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
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2. Overview of a WebCenter Installation
The WebCenter installation procedure involves a number of different steps that need to be performed
in a speciﬁc order.
The table below shows a list of the steps required to install WebCenter either for the ﬁrst time or as an
upgrade:
Step

Description

1

Check the Requirements and perform pre-installation work:

2

•

Hardware and Software Requirements on page 7

•

Pre-Installation Steps on page 18

Installing WebCenter on page 22:
1. Install SQL Server 2012/ 2017/2019 Express Edition on the Database Server on page
23
2. Install ArtiosCAD Enterprise on the Application Server on page 24
3. Install the WebCenter Application Server on page 26
4. Install the WebCenter Web Server on page 32
5. Start the WebCenter Services on page 33
6. Install the On-Board Graphics Engine (OBGE) on the Application Server on page 35

3

Testing WebCenter on page 37

4

Conﬁguring WebCenter on page 38:
1.
2.
3.
4.
5.
6.

6

Conﬁgure the OBGE on page 38
Conﬁguring the E-Mail Notiﬁcations on page 39
Secure your WebCenter Site with SSL on page 44
Install Certiﬁcates for LDAPS on the Application Server on page 56
Integrate WebCenter with a Workﬂow Production Server on page 59
Expose WebCenter to the Internet on page 62
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3. Hardware and Software Requirements
Attention: For the latest hardware and software requirements, please check the Esko website.
Attention: WebCenter 21.11 is an 'Agile Release' and might not ﬁt in the update strategy of all
customers. See WebCenter Release Scheme for details before planning to update to WebCenter
21.11.
It also has a FileStore and an On-Board Graphics Engine (OBGE), which is used to generate view data.

New IT Requirements since WebCenter 21.11
There are no speciﬁc new requirements for WebCenter 21.11. For the latest hardware and software
requirements, please check the Esko website.

New IT Requirements since WebCenter 14

Since 14, WebCenter runs on 64-bit operating systems only. Only Windows Server 2012 or later are
supported.

Entry Level (Two Server Systems Required)
WebCenter Entry Level requirements are based on an activity with 10 concurrent users active at any
time and less than 100 users in the system. Customers with higher performance needs should refer to
the Advanced Level requirements.
In the Entry Level setup, the installation of the Application Server and Database Server is combined
onto a single machine. The OBGE and the FileStore are on the Application Server.
For reasons of security the Web Server is always on its own dedicated computer and placed in a
demilitarized zone (DMZ). We recommend the use of hardware ﬁrewalls for creating the DMZ.

Advanced Level (Three or More Server Systems Required)
When the WebCenter Entry Level cannot meet the load requirements of the system, it is possible to
scale the system.
For reasons of security the Web Server will always be a separate computer in a DMZ.
Each of the other WebCenter components (Application Server, Database Server, FileStore and OBGE)
can be ooaded onto separate machines in different combinations.
For Advanced Level installations, it is recommended to choose the Advanced Installer option to allow
more custom conﬁguration, and to choose Extra Large for the Deployment Size.

Requirements
Category

Entry Level (Standard - < 100
users)

Advanced Level (Extra Large 100+ users)

Operating System

Microsoft Windows Server 2012
or better

Microsoft Windows Server 2012
or better
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Category

Entry Level (Standard - < 100
users)

Advanced Level (Extra Large 100+ users)

Processor - Application Server
with On-Board Graphics Engine

x86-64 compatible processor
(Intel or AMD), minimum 8 cores

x86-64 compatible processor
(Intel or AMD), minimum 12
cores, 6 + 6 per 100 users

Processor - All other WebCenter
Servers

x86-64 compatible processor
x86-64 compatible processor
(Intel or AMD), minimum 4 cores (Intel or AMD), minimum 6 cores,
2 + 4 per 100 users, 2 + 6 per 100
users for separate DB server

RAM Memory (Application Server
with DB and OBGE)

16 GB or more

36 GB or more

RAM Memory (Application Server
with OBGE)

16 GB or more

28 GB or more

RAM Memory (Application Server) 12 GB or more

18 GB or more

RAM Memory (Separate Database 12 GB or more
Server)

minimum 12 GB or the size of
the DB (whichever is larger), add
8 GB per 100 users

RAM Memory (Web Server)

6 GB or more

12 GB or more

Available hard disk space Application Server

20 GB or more

60 GB or more

Available hard disk space - Web
Server

20 GB or more

60 GB or more

Available hard disk space Database Server

40 GB or more

80 GB or more

Available hard disk space - File
Store

100 GB, should be expandable as
data storage grows with usage.
For WebCenter to perform
according to expectations,
the FileStore needs to be on
Windows ﬁle servers.
Recommended to use Windows
Server 2008 R2, Windows Server
2012 or Windows Server 2012 R2
and Windows Server 2016 as ﬁle
server (but ReFS data volumes
are not supported yet).

Display

8

1024 x 768 pixels, 16-bit color
minimum

1024 x 768 pixels, 16-bit color
minimum

WebCenter

Category

Entry Level (Standard - < 100
users)

Advanced Level (Extra Large 100+ users)

Media drives - Application Server

DVD-ROM or connection to
networked DVD-ROM drive

DVD-ROM or connection to
networked DVD-ROM drive

Media drives - Web Server

DVD-ROM or connection to
networked DVD-ROM drive

DVD-ROM or connection to
networked DVD-ROM drive

Network (all servers)

10/100/1000 Base-T Ethernet,
TCP/IP v4 protocol

10/100/1000 Base-T Ethernet,
TCP/IP v4 protocol

Database software

•

•

Microsoft SQL Server
•
2012/2014/2016/ 2017/2019
(Express Edition, Workgroup
Edition, Standard Edition,
Enterprise Edition)
Oracle 10g or 11g or 12c
•
Enterprise Edition

Microsoft SQL Server
2012/2014/2016 /2017/2019
(Workgroup Edition,
Standard Edition, Enterprise
Edition)
Oracle 10g or 11g or 12 c
Enterprise Edition

Note: Oracle 8i and 9i are no
longer supported.

Note: Oracle 8i and 9i are no
longer supported.

Notes
•
•

The Database Server needs 10 GB of free space on the partition containing the database ﬁles to
allow for database expansion.
If you install the Global Vision extension on the OBGE, the OBGE needs to be separated from the
WebCenter Application Server.
If you install the additional Automation Engine Processor module license for WebCenter, the OBGE
needs to be separated from the WebCenter Application Server.

•

The Application Server is the default location for uploaded ﬁles (also known as the FileStore).
Ensure it has at least 50 GB of available hard drive space, and that the disk space is expandable.
Alternatively, ﬁnd a network location with expandable disk space to specify as the ﬁle storage
location when loading the Application Server.

•

The Web, Application and Database Servers must have the same OS language, regional setting
(such as English (United States)), and time zone setting.

•

If you are using a Microsoft Hyper-V hypervisor virtual machine, do not install both the WebCenter
Web Server and the Esko Licensing software on this virtual machine.
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4. WebCenter Installation Tips
Licenses
•

WebCenter Licenses
To install WebCenter 21.11, request for the WebCenter 21.11 licenses.
The old WebCenter 21.x, 20,18.x, 16.x, 14.x or 12.x licenses will not work anymore.

•

WebCenter supports two types of licensing models. You can have counted licenses in the Named
User Model and Concurrent License Model where you can have licenses that are taken up during a
log-in sessions.
•

Named User Licenses: A named user license is an exclusive license of rights assigned to a
single software user. This License model lets you pay for the number of users you want to create
in WebCenter. This means that the purchased number of licenses (per type of users) limit the
number of users that can be created. Read more in: Licensing and Users and in this FAQ.

•

Concurrent Licenses:
In this model, you can create as many users as you want. The number of users who may use
the system at the same time is determined by your Concurrent Licenses. The licensing model
distinguishes between three types of users: guaranteed users, concurrent users, and editor
users.
Note: Since WebCenter 14.0.2, large installations from 50 concurrent users require a
WebCenter Advanced License. A special 'advanced' variant of the concurrent user licenses is
also needed in this case.

Network Licensing Tool
For WebCenter 21.11, you need to install ArtiosCAD Enterprise 21.07, this installation includes the
required Network License Manager.
To know more about Network Licenses, click here..

Server Conﬁguration
Port Conﬁgurations
Below you can ﬁnd the ports which need to be open/available for proper functioning of WebCenter:

10

•

Port 80 (HTTP) from the internet to the WebCenter Web Server (DMZ).

•

Port 443 (HTTPS) from the internet to the WebCenter Web Server (DMZ).

•

Port 80 (HTTP) from the LAN to the WebCenter Web Server (DMZ).

•

Port 443 (HTTPS) from the LAN to the WebCenter Web Server (DMZ).

•

Port 4444 from the WebCenter Web Server (DMZ) to the WebCenter Application Server (LAN).

•

Port 5445 from the WebCenter Application Server to the Automation Engine server (LAN) for
approval feedback

•

Port 25 (SMTP) from the WebCenter Application Server (LAN) to the Mail Server.

WebCenter

Note:
•
•

The following ports are internal ports for the Application Server and need not be conﬁgured on the
ﬁrewalls. However, if any of these ports are taken by another application, the Application Server will
not start. Ports: 8083, 8086, 1161, 1162, 1090.
The following ports are internal ports for the WebServer and do not need to be conﬁgured on the
ﬁrewalls. However, if any of these ports are taken by another application, the WebServer will not
start. Ports: 8081, 8009.

Note: It is recommended to install the external viewer during the installation process.
•

Database
The database shipped as default with WebCenter 21.11 is MSSQL 2012 / 2017 Express.

•

OBGE
In case the OBGE 21.11 is installed on the Web Server (not recommended), make sure to stop the EG
Web Server service before starting Tomcat.
Note: Since 16.1, Automation Engine no longer uses Hot Folders explicitly, but you can now
conﬁgure the FileStore JDF Hot Folder by creating an Access Point which is described in Create a
JDF Hot Folder (Access Point) for WebCenter.

•

IIS
If you move to WebCenter 21.11 from WebCenter 12.x, leaving the installation of IIS intact, a
change to IIS may be needed. In IIS, go to Application Pools and open the Advanced Settings for
DefaultAppPool. Make sure that ‘Enable 32-Bit Applications’ is set to ‘False’. After changing the
setting, click ‘Recycle’.

•

Simple or Advanced Installation
Since WebCenter 14, it is possible to choose between a Simple or Advanced installation. If the
Advanced installation mode is selected, the memory size allocated for the JBoss service on the
Application Server and the TomCat service on the Web Server need to be speciﬁed. Choosing the
Extra Large option is recommended for servers that are expected to experience a heavy load and
high concurrent user access.

•

Internal or External Viewer
In case of an Advanced installation, the Viewer service can be set to Internal or External. Selecting
External will make the Viewer service run as a separate process. Note that choosing External
requires extra ports to be opened between the Application and Web Server: 14444. And the
following ports need to be available for the application server: 1091, 3528 and 4446.

•

Database user
In case of an Advanced installation, it is possible to set a custom password for the WebCenter
database user.

•

Boards
Previously, in older versions of ArtiosCAD Enterprise, the Boards needed to be installed by running
a .bat ﬁle after the WebCenter installation. Since ArtiosCAD Enterprise 14.0, you can install the
Boards automatically during the ArtiosCAD Enterprise installation, this is highly recommended.

Servicing
•

Admin Console
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Since WebCenter 14, it is possible to inspect JBoss by going to: http://yourhost:8086/
admin-console.
•

Services
Since WebCenter14, you will only see the following services:
•
•
•

JBoss
Tomcat
CAD-X

The App-X and Search Crawler services are no longer needed since WebCenter 12.
Note: In order to run the services interactively, open the command prompt and go to ..\Esko
\Artios\WebCenter\ApplicationServer\NAMEOFSERVICE\bin for each service, and
run wcr_nameofservice_srv_cmdrun.bat. For example: C:\Esko\Artios\WebCenter
\ApplicationServer\JBoss\bin\wcr_jboss_srv_cmdrun.bat.
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5. Installation Checklist
The Installation Checklist can be used as a tool alongside the rest of the Installation Guide to ensure
you completed all the necessary steps during the installation. There are two versions, the ﬁrst one can
be used for a fresh installation, the second one can be used in case of an upgrade.

5.1. Installation Checklist for Fresh Installation
This checklist can be used whilst performing a fresh installation of WebCenter (meaning WebCenter
was not installed on the same machine(s) before).
Please complete the Installation Checklist in the same order as listed here.
Note: Do not run this installation from a network share.
On the Application Server...
Install ArtiosCAD Enterprise located on the WebCenter DVD.
Install License Server Components from the ArtiosCAD Enterprise Installer.
Activate Network Licenses via the Network License Manager:
WebCenter (Standard or Advanced)
CAD Engine
OBGE
Optional licenses
If you are going to use MS SQL Server (no prerequisites for Oracle):
Install MS .NET framework 3.5 (run the script from the WebCenter DVD to install it).
Install MS .NET framework 4.5 (run the script from the WebCenter DVD to install it).
Note: For servers with Windows Server 2012 or with access to the Internet, this will happen
automatically.
Install the SQL Server 2012 SP1 Express Edition Database engine for WebCenter or SQL Server
2017 Express Edition or SQL Server 2019 Express Edition.
Always install SQL Management Studio on the Application Server.
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Always install SQL Command Tool on the Application Server.
Create the local BGSYSTEM Windows user (run the script from the WebCenter DVD to create it)
and enter a password.
Create the FileStore folder and share it as a network folder with all rights enabled for the
BGSYSTEM user.
Install the Application Server component of WebCenter; build the Database schema and REBOOT.
Install the OBGE from the Automation Engine DVD by selecting the option: Install Automation
Engine 21.11 as On Board Graphics Engine (OBGE) for WebCenter.
Conﬁgure the Access Point (formerly known as Hot Folder) in the Automation Engine Pilot to
generate view ﬁles for graphic ﬁles.
On the Web Server...
Install and conﬁgure IIS 8 (Windows Server 2012) on the Web Server.
It is recommended to auto install IIS using the provided PowerShell Script from the installation
disk, to conﬁgure IIS on Windows Server 2012 or later.
Make sure that Enable 32-bit programs in IIS is set to False.
Increase the upload limit in the request ﬁltering.
Install the Web Server component of WebCenter and REBOOT.
On the Application Server...
Since WebCenter 12.1, services are started automatically. Verify that the following services are
started:
JBoss
CAD-X
Application Monitor
On the Web Server...
Verify that the following services have been started:
TomCat
Application Monitor
Connect to WebCenter in your browser: http://[WebServer]/WebCenter_Inst.
Username: admin. Password: [blank].
Change password.
Install the ArtiosCAD Defaults in English and Import the Boards (directly from the ArtiosCAD
Defaults Installer).
Run the CADX User Defaults installer, to install optimal Defaults for the WebCenter Cad-X service
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Run the Studio Defaults installer, to install Studio Print Finishing Proﬁles for working with
advanced material effects in 3D visualization

5.2. Installation Checklist for Upgrade
This checklist can be used whilst performing an upgrade installation of WebCenter 21.11 from an older
version.
Please complete the Installation Checklist in the same order as listed here.
Note: Do not run this installation from a network share.
On the Web and Application Server...
Stop all WebCenter services.
On the Application Server...
Backup the whole ..\WebCenter\ApplicationServer folder (make a copy, do not move it)
and backup the following:
FileStore
Database
Email conﬁguration (if you upgrade from a WebCenter< 12)
On the Web Server...
Backup the whole ..\WebCenter\WebServer folder (make a copy, do not move it).
Uninstall the old version of WebCenter on both Application and Web Server and REBOOT
both servers after uninstall. Delete all the sub folders present in ..\WebCenter
\ApplicationServer.
Remove all WebCenter instances in IIS on the Web Server.
On the Application Server...
Upgrade to ArtiosCAD Enterprise 21.07 located on the WebCenter DVD.
Upgrade the Network License Manager via the Install License Server Components from the
ArtiosCAD installer.
Upgrade WebCenter Licenses and dependants (CAD Engine and OBGE) to WebCenter 21.11.
If you are using MS SQL Server, make sure that SQL Management Studio is always installed on the
Application Server.
Install the Application Server component of WebCenter using the existing FileStore and
Database. DO NOT REBOOT YET
Re-apply email customization on the Application Server.
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Build the Database schema if this was not done during the installation.
REBOOT
Update to Automation Engine OBGE 21.11 and conﬁgure the Access Point (formerly known as Hot
Folder) in the Pilot to generate view ﬁles for graphic ﬁles.
On the Web Server...
Install the Web Server component of WebCenter.
Make sure that Enable 32-bit programs in IIS is set to False.
To be able to use Excel based lists from the Web Server, install a 64-bit driver (see link on the
WebCenter DVD). DO NOT REBOOT YET
Re-deploy WebCenter Instance(s) and re-apply customizations.
REBOOT
On the Application Server...
Since WebCenter12.1, services are started automatically. Verify that the following services are
started:
JBoss
CAD-X
Application Monitor
On the Web Server...
Verify that the following services have been started:
TomCat
Application Monitor
Connect to WebCenter in your browser: http://[WebServer]/WebCenter_Inst.
Username: admin. Password: [old admin password].
Install or merge the ArtiosCAD Defaults in English and Import the Boards (directly from the
ArtiosCAD Defaults Installer).
Install the ArtiosCAD Defaults in English and Import the Boards (directly from the ArtiosCAD
Defaults Installer).
Run the CADX User Defaults installer, to install optimal Defaults for the WebCenter Cad-X
service
Run the Studio Defaults installer, to install Studio Print Finishing Proﬁles for working with
advanced material effects in 3D visualization.
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6. CHILI-WebCenter Connection
6.1. Share between CHILI and WebCenter
A CHILI share is used to temporarily hold the ﬁles while registering them to the CHILI server.
WebCenter will create a sub folders corresponding to the CHILI environments in this CHILI share root
folder.
Note:
The share must have:
•
•

read and write permissions for WebCenter 'BGSYSTEM' user.
read permissions for CHILI server.

6.2. Requirements for Reverse Proxy for CHILI Server
IIS ports accessing CHILI over the WebCenter web server should be:
•

80 for IIS http

•

443 for IIS https

The https ports must have a security certiﬁcate attached to it in order to be able to work with Web
Server.
Note: The best practise is to install a properly signed certiﬁcate, matching the CHILI server hostname
(NOT the tricked hostname) on the CHILI server. In this scenario, the validation of the SSL certiﬁcate
will be smooth when the WebCenter Application Server makes a connection to it.
Alternatively, you may use a self-signed certiﬁcate. However, these are not supported for the
WebCenter WebServer. You may get SSL validation errors when the WebCenter Application Server
tries to connect to the CHILI server due to this.
As a work-around, use the WebCenter LDAP CertInstall tool:
•

Go to the <Installation Directory>\ApplicationServer\LDAP.

•

Run the following command:
CertInstall.bat

<chiliserver>:443

•

Select the right certiﬁcate to install by entering a digit.

•

Restart the JBoss.

This will solve the SSL validation problems.
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7. Pre-Installation Steps
Execute the following steps to make sure you have all the required information and materials for the
installation.
1. Log on to all servers as a local administrator user.
Attention:
Logging on as DOMAIN ADMIN does not ensure you are a member of the local Administrators
group.
Verify that the account you are using to log on to each machine belongs to the local
Administrators group before you continue!
2. Make sure you use compatible software versions:
a) Gather the installation media on CD or DVD for ArtiosCAD Enterprise, WebCenter, and
Automation Engine (OBGE).
b) Only very speciﬁc versions of ArtiosCAD Enterprise, WebCenter, and Automation Engine (OBGE)
work with each other.
You CANNOT assume that a new version or build of one product will be compatible with older
versions of the other products.
Software

Version

Build

ArtiosCAD Enterprise

......

......

WebCenter

......

......

Automation Engine

......

......

3. Check the licenses for the Esko installers:
a) Gather Graphics and CAD licenses.
b) If this is an upgrade, you will need to ask for updated license ﬁles.
c) Check the license ﬁles against your software order.
Verify that the licenses have the correct number of users, the expiration date if applicable,
and the correct ArtiosCAD Enterprise, WebCenter, and Automation Engine (OBGE) version
information.
4. Gather the required mail server information:
Note:
The mail server must be on the same network as the WebCenter Application Server.
Also, ensure this mail server has a send-only e-mail account already created for speciﬁc
use with WebCenter notiﬁcations (this usually requires creation of an account such as
webcenter@mycompany.com).
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Mail Server Information

Value

Mail Server Name

......

Mail Server IP Address

......

SMTP Port

......

WebCenter Sender Address

......

SMTP Authentication User Name

......

SMTP Authentication Password

......

5. Gather the required database information from the database administrator:
Database

Item

Value

SQL Server

server name

......

“sa” password

......

database instance name

......

database port (default is
1433)

......

server name

......

‘sys’ password

......

TNS name

......

System ID (SID)

......

database port (default is
1527)

......

Oracle Server

6. Ask the database administrator whether a custom password for the 'WebCenter' database user will
be required and if so, retrieve the expected target password for this database user.
7. Perform a Web Server health check:
a) We highly recommend not to begin the install with the Web Server inside the DMZ. It is best to
conﬁgure on a local LAN ﬁrst.
Get all applications installed, conﬁgured, and fully functional before moving the Web Server
inside the DMZ. Otherwise any required troubleshooting will be dicult and will take longer than
needed.
b) Verify that Internet Information Services (IIS) is installed and its services are started: IISADMIN
and W3SVC (World Wide Web Publishing).
c) Make sure the Server service is running.
8. Test the mail server connection:
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Note:
Ensure that you can use telnet commands and that its port is not blocked in any way.
Make sure you test this before starting the installation. IT Administrators often block the required
SMTP ports.
a) From the Application Server, open a command prompt.
b) Use a telnet command with the following syntax: telnet <mail_server_name_or_ip>
<smtp_port#>.
For example, my mail server name is mail.eskowebcenter1.com and my SMTP port is 25.
I would type: telnet mail.eskowebcenter1.com 25.
You are looking for a successful response (for example like the one below); a 220 response is
good.
telnet mail.eskowebcenter1.com 25Trying 62.204.32.250...Connected to
mail.eskowebcenter1.com (62.204.32.250).220 mail.eskowebcenter1.com Mail Server;
Mon, 2 Jun 2014 11:26:40 EST

Type QUIT to exit the telnet command.

9. Make sure the Server service is running on the Application Server.
10. Check the Database Server:
a) Ensure the correct database engine, version and service pack are installed. See section Install
SQL Server 2012 Express Edition on the Database Server.
b) For SQL Server 2012/2017/2019 or Express 2008/2012/2017/2019 verify these conﬁgurations:
•
•
•
•

Must be conﬁgured to run in Mixed Mode for authentication;
Language/Character set of SQL Server must match the Operating System language;
TCP/IP must be enabled.
If a named instance is used, the SQL Server Browser must be set to start automatically (and
must be running).
c) This assumes that the system is protected by an external ﬁrewall.
11. Check performance for all servers:
a) For all servers (Web, Application, Database), ensure Windows System Performance is set to
Adjust for Best Performance:
Go to Control Panel > System > Advanced and select Adjust for Best Performance from the
Performance list.
b) Ensure Control Panel > Automatic Updates is set to Download updates for me, but let me
choose when to install.
Windows Updates have been known to interfere with WebCenter operation: some updates lock
down ports and stop services related to web and internet.
It is your responsibility to test Microsoft updates before applying them to production servers.
c) Ensure Windows Firewall is disabled:
Go to Control Panel > Network Connections, right-click on the active network connection and
choose Properties. On the Advanced tab, ensure Internet Connection Firewall is disabled.
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d) Stop and temporarily disable virus software.
Temporarily stop virus services on the Web Server and the Application Server as they are known
to interfere with the WebCenter installation script.
Only after the software is installed should you enable the virus software again.
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8. Installing WebCenter
Installing WebCenter is a multi-step process spread over two or three servers depending on your
conﬁguration. We strongly recommend having three servers.

8.1. Overview of the Installation Procedure
This is a broad overview of the steps required to install WebCenter.
1. Perform the Pre-Installation Steps on page 18.
2. On the Database Server, optionally create a database called WebCenter4_0 if using Microsoft SQL
Server. If you do not create the database at this point, it will be done by the WebCenter installer.
If using Oracle, we recommend that the SID (System Identiﬁer) of the database be WCenter,
but it can be anything; just make sure you know the exact name so you can enter it while loading
WebCenter on the Application Server.
3. On the Application Server:
a) If using Microsoft SQL Server or SQL Server Express Edition, install Microsoft SQL Server
Management Studio (if you have not done so already). This is provided as part of the MSSQL
Express installer provided on the DVD. If you are using Oracle, it is advised to also install SQL
Developer Studio, which can be downloaded from the Oracle web site.
b) Install ArtiosCAD Enterprise.
Even if the Application Server already has a version of ArtiosCAD Enterprise on it, you must load
the version that came with WebCenter.
For more information on loading and conﬁguring ArtiosCAD Enterprise, refer to the installation
instructions on its media.
c) Activate the Licenses on page 25
d) Install the WebCenter Application Server.
4. Run the Database Schema Scripts on the Application Server.
This is only required if the database schema scripts were not run automatically, or if the automatic
run failed. Running the database schema scripts automatically is preferred. If needed, it is still
possible to run the database scripts manually from the Application Server.
5. On the Web Server, install the WebCenter Web Server.
Reboot the Web Server machine if prompted.
6. Start the WebCenter Services:
a) On the Application Server, start JBOSS and CAD-X.
b) On the Web Server, start Tomcat.
Note: These services are set to start automatically by the installer and will thus be started
automatically after each machine reboot. If you prefer to start the services manually, you may
set them to start manually by changing their properties in the Services applet via Control Panel >
Administrative Tools.
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Note: Since WebCenter 12 a new monitoring service is installed and started automatically. This
service can be used by your WebCenter support agent for troubleshooting.
7. Install the On-Board Graphics Engine (OBGE) from the Automation Engine media. This will take about
a half hour.
Note:
You must install the OBGE even if you are running a separate Automation Engine production server.
The OBGE will handle ﬁles uploaded through the WebCenter user interface, reducing the load on
your Automation Engine production server.
WebCenter is now installed.
8. Log on the WebCenter web interface and:
a) Change the administrator password.
b) Conﬁguring the E-Mail Notiﬁcations on page 39 if you will be using it.
9. Install the ArtiosCAD defaults.
See Loading the ArtiosCAD Defaults for details.

8.2. Install SQL Server 2012/ 2017/2019 Express Edition on
the Database Server
Microsoft SQL Server 2012 / 2017/2019 Express Edition (supplied with WebCenter) is a free version that
can serve as the database engine for WebCenter.
To install it, use the Install the SQL Server 2012 / 2017 /2019 Express Edition database engine for
WebCenter link on the WebCenter installation media.
Following steps describe how to install the MSSQL Server 2012/ 2017/2019 Express database on a clean
system:
1. When the SQL Server Installation Center launches, select the option New SQL Server stand-alone
installation or add features to an existing installation.
2. If prompted, accept the License Terms and click Next.
3. A quick check will be done and the installation will be prepared.
4. Select the Features you wish to install. If unsure, enable all except LocalDB.
5. On the Instance Conﬁguration screen, select Named Instance and name your instance
WEBCENTER. You can also change the instance root directory if you want.
6. On the Server Conﬁguration screen, you can deﬁne separate accounts for each service, leave as
default.
7. You can also specify your Database Engine Collation, leave as default.
8. On the Database Engine Conﬁguration screen, choose the Mixed Mode authentication type.
9. On the same screen, specify the SQL Server system administrator (sa) password.
10. On the Reporting Services Conﬁguration screen, select Install and Conﬁgure and click Next.
11. The system will now continue with the installation. The last screen shows that the installation
process was completed successfully. You may be asked to restart the computer.
12. If you now inspect your Programs, you should see Microsoft SQL Server 2012 / 2017 listed, along
with other tools like SQL Server Management Studio.

23

8

8

WebCenter
13. Install the SQL Command Tool.
14. Launch the SQL Server Management Studio to check the connection to the Database Engine.
15. In case it has not been created yet, add a new database named WebCenter4_0.
16. Launch the SQL Server Conﬁguration Manager to check the TCP/IP and SQL Server service
statuses.
17. Choose SQL Server Network Conﬁguration > Protocols for WEBCENTER > , make sure TCP/IP is
set to Enabled for WebCenter.
18. In the SQL Server Services section, restart the SQL Server service. Also, make sure the SQL Server
Browser service is running.
19. If Microsoft SQL Server 2017 Management Studio is installed, you will also need to install the
Microsoft SQL Command Line Utility (sqlcmd).

8.3. Install the Application Server Components
8.3.1. Install ArtiosCAD Enterprise on the Application Server
1. Log on to the Application Server as a member of the local Administrators group.
2. Load the ArtiosCAD Enterprise media that came with WebCenter.
Important:
Even if the Application Server already has a version of ArtiosCAD Enterprise on it, you must load the
version that came with WebCenter. In the case of WebCenter 21.11, you need ArtiosCAD Enterprise
21.07.
Make sure to also run the Install Network License Components installer from the ArtiosCAD
Enterprise Installer.
In order for WebCenter to output PDF ﬁles, the ArtiosCAD PDF option must be purchased and then
chosen when installing.
For more information on loading and conﬁguring ArtiosCAD Enterprise, refer to its installation
instructions on the ArtiosCAD media.
3. In the Esko ArtiosCAD Setup window, click Install Esko ArtiosCAD Enterprise 21.07 en.
Depending on your system conﬁguration prior to loading ArtiosCAD, the Microsoft Data Access
Components and MSXML 6 may be copied to your system.
If the system prompts you to reboot, do so; the installation program will resume automatically when
you log in after the system comes up again. Do not postpone rebooting if the system requests it.
4. The Esko ArtiosCAD Enterprise 21.07 en InstallShield Wizard opens.
a) In the Licensing Method screen, choose Network Licenses. Make sure the Server ﬁeld contains
the name of the Application Server (it should be ﬁlled in by default).
b) In the Setup Type screen, choose Typical for a regular WebCenter installation, or Advanced if
you will be working with ArtiosCAD Enterprise.
c) In the Feature Selection screen, make sure PDF Import/Export is enabled.
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Note: You will only see this screen when performing an Advanced setup to work with ArtiosCAD
Enterprise.
d) In the Advanced Options screen, you can leave the default options selected. If you wish to
change them please see the ArtiosCAD documentation for details.
Note: You will only see this screen when performing an Advanced setup to work with ArtiosCAD
Enterprise.
e) In the User Files Folder screen, keep the default location for the storage of user ﬁles, or Change
it if desired. If you change the location to another system, use a UNC locator (for example \
\system2\designs) instead of a mapped drive letter.
Note: You will only see this screen when performing an Advanced setup to work with ArtiosCAD
Enterprise.
f) Click Install.
g) Once the installation is complete, click Finish to close the installer.
5. If the system asks you to reboot, do so.
Note: You will need to perform extra conﬁguration later to work with ArtiosCAD Enterprise.
Note: Since ArtiosCAD Enterprise 14.0, you can install the Boards automatically during the
ArtiosCAD Defaults installation, this is highly recommended. In case you do not choose to install the
Boards during the ArtiosCAD Enterprise installation, you will have to import them manually later.

Create a Detailed Installation Log
For Installation debugging and troubleshooting purposes, you can create a detailed installation log ﬁle
for any Esko Installer programs. To do this:
Run setup using the following syntax: Path+program space /v”/l*v space path+logﬁlename
•

For example: For ArtiosCAD Enterprise installation from CD-ROM in my D:\ drive,

•
•

Open a command prompt and Change to the D:\ drive
Type: setup /v”/l*v c:\temp\ACsetup.log”

8.3.2. Activate the Licenses
If you have not done so already, install the Network License Components from the ArtiosCAD
Enterprise Installer ﬁrst.
Activate your licenses using the Esko Network License Manager.
Note: To perform this task, consult the Network License Manager User Manual.
You need to activate:
•
•
•

your ArtiosCAD Enterprise license,
your WebCenter licenses (your basic WebCenter license and any additional WebCenter license you
have, for example WebCenter Task Management, WebCenter Advanced Approval, Reporting, etc.).
your license for the OBGE (Automation Engine license).
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8.3.3. Install the WebCenter Application Server
The Application Server components of WebCenter can be installed from a link on the installation
media.
Before doing so, click the link on the DVD to Create the local BGSYSTEM Windows user, if this user
was not created earlier. The BGSYSTEM user creation tool will give you the option to set a custom
BGSYSTEM user password.
1. Log on to the Application Server as a member of the local Administrators group.
2. Insert the WebCenter media into the media drive, and click Software Installation on the menu that
appears at left, then Install WebCenter 21.11.
3. The setup wizard opens with a Welcome screen. Click Next.
4. In the License Agreement screen, read the agreement, and if you agree to it, select I accept the
terms in the license agreement and click Next.
5. Select either Simple (default) or Advanced Installation. Keep Simple (default) selected unless you
mean to specify non-default values for either Installation Size, Image Viewer Service or Database
User management.
6. In the Custom Setup screen:

a) Click the icon next to WebServer and select This feature will not be available.
b) Click the icon next to Application Server, and select This feature, and all subfeatures, will be
installed on local hard drive.
c) If desired, click Change to change the installation folder.
d) Click Next.
7. In the WebCenter File Storage Folder screen, choose the location where all data ﬁles uploaded to
WebCenter will be stored (the FileStore).
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Note: If you want to change the FileStore location, click Change... and browse to your desired
location or enter a UNC address. Using a UNC location such as \\system\sharename
\FileStore is the most reliable option. The FileStore should be on a partition with at least 50 GB
of free space.
Troubleshooting:
If the installer fails to create the FileStore, it will give you a message saying that you have to set it up
manually.
Go to the folder that you will use as a FileStore (by default, C:\Esko\Artios\WebCenter
\FileStore, or the location of your choice), and share it (typically to the user BGSYSTEM).
Click Next.
8. In the Web Server System screen, enter the name you will give to the Web Server and click Next.
Note: Once you have completed the installation and launched WebCenter, the Application Server
must be able to resolve the Web Server name you have entered here into an IP address.
9. In the Database Conﬁguration screen, enter your database information:.
a) Choose your Database program (Microsoft SQL Server or Oracle).
b) Enter the name of your Database Server in Database server system.
c) If you chose...
•

Microsoft SQL Server, enter your Database Instance Name. By default, this is WEBCENTER
(using the SQL Server 2012/2017 Express Edition installer on the WebCenter installation
media created this instance).

•

Oracle, enter your Database System Identiﬁer (SID).

Click Next when done.
10. A custom WebCenter database user password can be set. In that case you will need to provide a
password value. This screen will only be shown in case of an Application Server installation.
Note: This screen appears only for Advanced installation.
11. Choose between a Standard (default) and an Extra Large deployment. If Extra Large is selected,
Tomcat and/or JBoss (depending on the server being installed) will be able to allocate 3 times more
memory as is the case with a Standard installation.
Note: This screen appears only for Advanced installation.
12. Choose between an Internal or External (default) View server. If Internal is selected, the View
Server runs inside the JBoss process. If External is selected, an additional process running the
View Server will be started automatically. For the External view server to work, other ports need to
be open in the ﬁrewall between the web and the application server: 14444.
Note: If installing Web and Application server component separately – a matching mode (either
external or internal) has to be selected for both the Application server and Web server – otherwise
the Viewer will not function properly.
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13. Click Install in the Ready to Install the Program screen.
14. The Esko Station Information Service may be installed if this is the ﬁrst Esko software being
loaded on the machine.
If it installs, click Continue when it is done, or wait 10 seconds for the process to continue
automatically.
15. Click Finish when the installation completes.
16. If prompted, reboot the system.
Attention: This is important; do not postpone this step!
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Note:
If during the installation a custom password was set for the local BGSYSTEM user the following
WebCenter Services need to have their Log On information changed to reﬂect the custom
password:
•
•

WebCenter JBoss Application Server
WebCenter Cad-X Server

In the server Services, right-click the WebCenter Service and choose Properties. Go to the Log On
tab of the properties window and update the password of the BGSYSTEM user to the password that
was set earlier. Click Apply, go back to the General tab, and click Start to start the Service.

8.4. Run the Database Schema Scripts on the Application
Server
Since WebCenter 12.1, it is no longer necessary to run the database schema scripts manually. The
database schema scripts can now be run from the installer dialog, for both local and remote databases.
When the database scripts are run automatically, a system console readout window will show feedback
on the progress. Individual SQL statement blocks are displayed as they are being executed.
To run the database scripts automatically, database connection parameters need to be entered in the
Database Conﬁguration dialog which is displayed during the installation of the WebCenter Application
Server:
1. Choose your database type from the Database program list.
2. Enter the database host name in the Database Server system ﬁeld.
3. For SQL, enter the instance name in the Database Instance Name ﬁeld.
4. For Oracle, enter the SID in the Database System Identiﬁer (SID) ﬁeld.
5. The checkbox Run DB update scripts during installation determines whether the database schema
scripts are run automatically during installation (preferred), or not.
6. If running the scripts automatically is enabled, the DB sysadmin connection password ﬁeld
becomes available. Enter the password of the default database administrator user for your
Database Server in this ﬁeld.
If you still want to run the scripts manually, do the following:
1. Locate the ServerTools\update_db.bat ﬁle in your WebCenter installation folder (for
example C:\Esko\Artios\WebCenter\ServerTools\update_db.bat).
2. Run this ﬁle with the appropriate parameters in the console.
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Tip:
Run this ﬁle without parameters ﬁrst to see help about which parameters you need to use.
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If you have a SQL database, you will see this:

•

If you have an Oracle database, you will see this:
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8.5. Install the Web Server
8.5.1. Uninstall IIS on the Web Server if Conﬁgured Incorrectly
In some cases IIS may already be installed on the Web Server, but conﬁgured incorrectly. For example,
your hosting company may have set up IIS for you. In this case, IIS needs to be uninstalled. After which
it can be installed again and conﬁgured correctly.
The procedure below describes how to uninstall IIS 7.
1. Start the Server Manager.
2. Navigate to the Roles section using the navigation tree.
3. Click Remove Roles.
4. The Remove Roles Wizard is started, use this to remove the IIS role. Removing roles and services
from the server can take a couple of minutes.
5. You may get prompted to restart your server. If so please do this.

8.5.2. Install IIS on the Web Server
If IIS is not installed on your Web Server, you need to install it. The procedure below explains how to IIS
8 on Windows Server 2012.
Note: From WebCenter 18.1 installation, IIS can also be installed with a script provided in the
Installation disk.
1. Open the Server Manager.
2. IIS 8: In the Select installation type screen, select Role-based or feature-based installation.
3. IIS 8: In the Select destination server screen, select the appropriate server (local is selected by
default) and click Next.
4. In the Select server roles screen, select Web Server (IIS).
If the wizard prompts you to add features required for the Web Server, do so.
5. IIS 8: In the Select features screen, you do not need to add any additional features. Click Next.
6. IIS 8: Click Next in the subsequent Web Server Role (IIS) screen as well.
7. In the Select role services screen:
a) Enable ASP, ISAPI Extensions and ISAPI Filters in the Application Development section.
If the wizard prompts you to add role services required for ASP, do so.
b) In Health and Diagnostics, enable HTTP Logging, Logging Tools, Request Monitor and Tracing.
c) In Management Tools, enable IIS Management Tools and IIS 6 Management Compatibility, IIS 6
Metabase Compatibility, IIS 6 Scripting Toolsand IIS 6 WMI Compatibility
d) In Common HTTP features, make sure Default Document, Directory Browsing, HTTP Errors and
Static Content are enabled.
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e) In Security, make sure Request ﬁltering is enabled.
f) In Performance make sure to enable Dynamic and Static Content Compression.
8. In the Conﬁrm installation selections screen, check the settings and click Install.
This installs the IIS 8 Role with the settings you have selected and the default settings.
The Installation Results screen should show Installation succeeded.

9. Click Close to exit the wizard and restart the server if prompted.

8.5.3. Extend the Upload Limitation
IIS 7 has a limitation on how much you can upload at once (30 MB). You can change it to 2GB by
following these steps:
1. Open IIS Manager.
2. Select the website for which you want enable large ﬁle uploads.
3. In the main window, double click Request ﬁltering.
4. Once the window is opened you may see a list of tabs (ﬁle name extensions, rules, hidden
segments…).
Regardless of the tab you select, right-click in the main window and select Edit Feature Settings.
5. Modify the Maximum allowed content length (bytes): change the value to 2000000000 (a 2 and 9
zeros) to be able to upload ﬁles close to 2GB.

8.5.4. Disable 32 Bit Applications
Note: Only do this if you previously had WebCenter 10.x or 12.x installed on the same system.
Previously, 32 Bit Applications needed to be enabled. Now however, this settings needs to be disabled.
1. In IIS, go to Application Pools and select the DefaultAppPool.
2. Click Advanced Settings..., then set the Enable 32 Bit Applications option to False and click OK.
3. Click Recycle... at right.

8.5.5. Install the WebCenter Web Server
The Web Server components of WebCenter can be installed from a link on the WebCenter installation
media.
1. Log on to the Web Server as a member of the local Administrators group.
2. Ensure that Internet Information Services (IIS) has already been loaded by verifying that the
Internet Information Services applet is in Administrative Tools in the Control Panel.
Note: If it has not been loaded, you must load it through Add/Remove Windows Components in
Add/Remove Programs in the Control Panel.
3. Insert the WebCenter media into the media drive, and click Software Installation on the menu that
appears at left, then Install WebCenter 21.11.
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4. The setup wizard opens with a Welcome screen. Click Next.
5. In the License Agreement screen, read the agreement, and if you agree to it, select I accept the
terms in the license agreement and click Next.
6. In the Custom Setup screen:
a) Click the icon next to WebServer, and select This feature, and all subfeatures, will be installed
on local hard drive.
b) Click the icon next to Application Server and select This feature will not be available.
c) If desired, click Change to change the installation folder.
d) Click Next.
7. In the Option Selection screen:
a) Enter the name of the Application Server.
This should be a different machine than the one currently running the installation.
Note:
You cannot conﬁgureWebCenter with IP addresses. If the web server is not able to ﬁnd the
application server via name resolution, you can map the IP address of the application server
and the hostname of the application server in the C:\Windows\System32\drivers\etc
\hosts ﬁle. For example: 10.31.140.69 myappserver.
•

Read also: https://wiki.esko.com/pages/viewpage.action?pageId=76730042.

•

Conﬁguring to use NAT translation.

b) If you want to install WebCenter using an already-existing IIS website (rather than the Default
Web Site), select it in the list.
c) Click Next.
8. Click Install.
9. The Esko Station Information Service may be installed if this is the ﬁrst Esko software being
loaded on the machine.
If it installs, click Continue when it is done, or wait 10 seconds for the process to continue
automatically.
10. Click Finish when the installation completes.
11. Reboot the machine if prompted.

Start the WebCenter Services
After installing WebCenter, you need to start its services using the Services applet in the Windows
Administrative Tools.

Start the WebCenter Services on the Application Server
1. Log on to the Application Server as a member of the local Administrators group.
2. Click Start > Settings > Control Panel > Administrative Tools > Services.
3. Select the WebCenter JBOSS Application Server and click Action > Start.
4. If not started yet, select the WebCenter Application Monitor service and click Action > Start.
5. Select the WebCenter CAD-X Server and click Action > Start.
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6. If you want to change the services to start automatically when the machine reboots, do so now:
a)
b)
c)
d)

Right-click a WebCenter service and choose Properties.
In the General tab, choose Automatic in the Startup type list.
Click OK.
Repeat for each service that has to start automatically.

7. Close the Services tool and log off.

Start the WebCenter Services on the Web Server
1. Log on to the Web Server as a member of the local Administrators group.
2. Click Start > Settings > Control Panel > Administrative Tools > Services.
3. Start the Tomcat service:
a) Right-click Tomcat Web Server and choose Properties.
b) In the General tab, choose Automatic in the Startup type list.
This makes the service start automatically when the machine reboots.
c) Click OK to close the Properties dialog.
d) Select the Tomcat Web Server and click Action > Start.
4. If not started yet, select the WebCenter Application Monitor service and click Action > Start.
5. Close the Services tool and log off.

Easily Identify when WebCenter is Ready to Access
WebCenter services loads a lot of data into memory during startup of its services. It is important to
watch the CPU activity before accessing a WebCenter site.
You want both the Web Server and the Application Server to have a CPU activity of under 5% before
accessing the site, otherwise all components may not have started and you may experience error
messages. Another way is to check whether wcr_jboss_srv.exe threads exceed 160 and
wcr_tomcat_srv.exe threads exceed 100.
To help watch the CPU activity easily, add the CPU performance monitor to the system tray of each
WebCenter server. To do this (on both the Web Server and the Application Server):
1. Create a new shortcut in theStart Menu > Programs > Startup folder.
2. Browse to Windows\system32\TASKMGR.EXE.
3. Set the shortcut to Run "Minimized".
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8.6. Install the On-Board Graphics Engine (OBGE) on the
Application Server
The Automation Engine On-Board Graphics Engine or OBGE is required for WebCenter systems to
generate view data.

8.6.1. How to Perform the Automation Engine 21.11 System Readiness Check
Before you install the OBGE, a System Readiness Check is required. This checks whether the operating
system is suited for installing and running this Esko product.
1. On the DVD, in the section Software installation, click the type of installation that ﬁts your purpose
(as explained in Types of Installations).
2. In the section Installation, under Instructions, click Run the Automation Engine Readiness Check.
3. At the end of the Readiness Check, read the resulting messages carefully.
4. If the Readiness Check resulted in any problem, correct it before proceeding.
5. Click Exit.

8.6.2. How to Install the Prerequisite Components
Depending on the products to be installed on this particular system, various components are required
for installation. The installation wizard for these prerequisite components checks the licenses, lists the
prerequisite components to install, requests conﬁrmation for installation and then installs the required
components.
The installation wizard installs the following components:
•

Microsoft Visual Studio Redistributables

•

Database Engine for the Automation Engine components (if you choose a Standard Automation
Engine Installation)

Follow these steps:
1. On the DVD, in the section installation, click Install the Prerequisites Components.
2. Follow the instructions of the installation wizard.
3. When you choose a Standard installation, when asked to enter a password for the SQL Server, enter
a Password, conﬁrm it and click Use Password to use a different password, for example because of
"Strong Password" requirements.
You can know more about Installation of Automation Engine in this KB article
Note: During the pre-installation of the Database Engine for Automation Engine, the
Microsoft .NET Framework will be installed. You may get a warning saying that the system needs
to be rebooted, followed by a fatal error "The SQL Server instance is not installed". If this happens,
reboot your server and install the prerequisites again.
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4. Depending on your activated licenses, the Automation Engine Prerequisite Components
Installation process may ask you separately about the CAD-X component installation for both the
Standard Edition component and the Enterprise Edition component. If the Automation Engine is
installed on the Application server, Click No.
5. Click Exit.
You will be redirected to the installation page to continue with the next step.

8.6.3. How to Install Automation Engine 21.11
1. After running the System Readiness Check and installing the License Server Components, when
all prerequisites are fulﬁlled, you can start the installation.
2. Click the Install Automation Engine 21.11 link on the installation page.
The Automation Engine 21.11 Software Installation wizard will open up.
3. Follow the instructions of the installation wizard.
4. Read the Software and Data license agreement carefully and select Yes, I accept the license
agreement.
5. When asked to select the products to install on this system, select Automation Engine 21.11.
The group Common Components cannot be deselected and will be installed on all systems.
6. Select the Destination Folder for the chosen products or accept the defaults.
7. Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.
In case of a clean installation, a pop-up dialog asks the user name and password to use as the System
Account for installing the Windows services. The proposed default user name is BGSYSTEM and the
password must be provided, either for an existing local user or domain user, or for a local user to be
created. The check continues until a strong enough password is provided. If the password does not
match for the existing user, an error dialog will indicate “wrong user name and password".
Note: You can later change this system user using the Server Conﬁg tool on the AE server itself.
Note: Learn more about Users and Groups in the separate chapter Pre-Install IT Requirements.
After installation of Automation Engine, a shortcut named "Automation Engine Client Apps" is put on
the desktop of the server computer.
Double-click this shortcut to open the Automation Engine Client Apps web page in your default
browser.
This page describes the two types of client applications:
•
•
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Desktop client applications (Pilot or Shuttle): These need to be installed on each workstation from
where you want to use Automation Engine.
Browser based client applications: These run inside a browser and do not need to be installed. You
may want to bookmark some speciﬁc pages.
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9. Testing WebCenter
On the Application Server and the Web Server, ensure IIS and the WebCenter services are started and
conﬁgured to start automatically.
After starting/restarting the WebCenter services, always wait a few moments until the CPU processor
activity on both servers become idle (<5%) before attempting to access the login page.
Testing each facet of WebCenter in the exact order below helps to easily and quickly identify points of
failure, if any.
•
•
•
•
•
•
•

IIS Connectivity – use IIS Manager to access the WebCenter_Inst site
IIS Security settings – can access the home page after logging in
Database connection and Schema – can add a new record to the database
FileStore connectivity – can write a ﬁle to the FileStore and then retrieve it
View Data generation – can upload a graphic ﬁle and the OBGE does its job
View and Annotate applet – can launch the applet successfully on a Graphic ﬁle
View the status in the Trouble shooting tool for View Server Deployment Status
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10. Conﬁguring WebCenter
10.1. Conﬁgure the OBGE
The Pilot lets you conﬁgure the Automation Engine On-Board Graphics Engine (OBGE) for use with
WebCenter.
You must create a container and a hotfolder pointing to the WebCenter FileStore.

10.1.1. Create a Container
1. Log on to the Application Server as a member of the local Administrators group.
2. Double-click the Pilot icon on the desktop.
3. In the Logon Information dialog, enter BGSYSTEM as the User Name and the enter the same
password that is set for the BGSYTEM in WebCenter. Type the name of the Application Server in
Server Name. Click OK.
This opens the Pilot. User creation in Automation Engine is done by following steps provided here.
4. Go to Tools > Containers to open the Containers window.

To more about Containers in Automation Engine, you can read here.
5. In that window, go to File > New or click

.

This opens the Create Container Wizard.
6. In the Welcome screen, click Next.
7. In the Location of the Job Container screen, select Existing Shared Folder and click Next.
8. In the Location of the Network Folder screen, type the name of the Application Server in the
Computer Name ﬁeld and click Next.
9. In the Select the shared folder screen, select the FileStore share and click Next.
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10. Click Finish and close the Containers window.

10.1.2. Create a JDF Hot Folder (Access Point) for WebCenter
1. Choose Tools > Access Points from the Pilot main menu.
2. Click the Create a new Access Point button.
3. Choose type Folder and click OK.
4. Enter a Name.
5. In the Folder Settings tab, speciﬁy the hotin folder. This should look like: ﬁle://myserver/FileStore/
JDFHotfolder/hotin.
6. In the Monitoring tab, set Check every...minutes to a low number preferably, the recommended
setting is 1.
7. In the Automatic Actions tab, ﬁll in the hotout folder in the Move File to and Output Folder ﬁelds.
This should look like: ﬁle://myserver/FileStore/JDFHotfolder/hotout. Make sure Action is set to
Process JDF.
8. Click OK.
The Hot Folder/Access Point now appears in the Pilot and is ready for use.

10.2. Conﬁguring the E-Mail Notiﬁcations
Use the E-Mail Notiﬁcations page to conﬁgure the e-mail environment for the notiﬁcations framework.
Only WebCenter Administrators can access this page.

10.2.1. Conﬁgure E-Mail Notiﬁcation
While logged in to the WebCenter web interface as an administrator:
1. Go to Admin > Conﬁguration > E-Mail Environment Setup.
2. Set up your e-mail environment:
Setting

Description

E-Mail Service Protocol

WebCenter only supports the SMTP protocol.

E-Mail functionality
enabled

To enable/disable e-mail functionality.

E-Mail debugging output
in log

To enable/disable e-mail debugging output in log ﬁles.

E-Mail Service Host

The address for the preferred mail server that will act as the
server for dispatching WebCenter e-mail notiﬁcations (this
server has to comply to the selected protocol type (see above)).
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Setting

Description

E-Mail Service Port
Number

The port number on which the deﬁned mail server is listening for
incoming e-mails.

Outgoing E-Mail
Notiﬁcations' "FROM"
Address

Supply a valid e-mail address. This will be used in the "From" email header for every e-mail sent by WebCenter.

Use TLSv1.2

Select this option to use TLSv1.2 when you are trying to connect
over SSL to the SMTP server. WebCenter uses the STARTTLS
protocol command to indicate that, it can upgrade the insecure
connection to TLSv1.2. To ensure that TLSv1.2 is used during the
connection, the SMTP server should be conﬁgured to prevent
insecure connections.
Note: This however does mean that if the smtp server doesn’t
support TLSv1.2, the insecure connection will be used instead.

E-Mail Session
Authentication

Select this option if the mail server connection requires
authentication with a user name and password.

E-Mail Service
Username

Provide the mail account user name if authentication is required.

E-Mail Service Password

Provide the mail account password if authentication is required.
Note: This password is stored in an encrypted form.

3. Click Send Testing E-mail.
The Test E-Mail Environment Settings page appears.

4. Type a Recipient address and click Send E-mail.
WebCenter attempts to send an e-mail to the recipient.
The E-Mail Conﬁguration page appears, displaying a message depending on the result of the test:
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•

Test E-Mail Sent: The environment is set up correctly.

•

JMS System Error: Communication with the JBoss' proprietary messaging framework failed.
An administrator should check the JBoss server conﬁguration and/or log ﬁles for possible
causes.

•

Mail Server Connection Error: The connection to the speciﬁed mail server did not succeed.
Either the data the administrator supplied on the e-mail environment setup page was incorrect,
or the mail server is currently down.
An administrator should either check the e-mail environment settings for possible misspellings
or contact the mail provider as to the status of the mail server.

Note: The settings you deﬁned are saved in the database. For updates from older WebCenter
installations, the email setup is ﬁrst loaded from the old emailconfig.xml ﬁle and the settings
are subsequently stored in the database.

10.3. Conﬁgure WebCenter for Use with ArtiosCAD
Enterprise
10.3.1. Conﬁguring BLOBs
ArtiosCAD Enterprise supports the use of BLOBs in the database. BLOBs are Binary Large OBjects ﬁles stored as data in the database. Using BLOBs is transparent for the user.
When you conﬁgure ArtiosCAD Enterprise to use BLOBs, it also stores managed documents in the
WebCenter FileStore as a cache to improve performance. If you delete a ﬁle from the FileStore, the
next time you save it in ArtiosCAD Enterprise, it will be recreated in the FileStore from the BLOB.
Note:
You should decide if you want to use BLOBs when you install WebCenter. Switching to using BLOBs
after having used ArtiosCAD Enterprise is not recommended or supported.

Editing appconﬁg.xml on the Application Server
To enable BLOBs, you must change a line in a conﬁguration ﬁle on the Application Server. On the
Application Server:
1. Log in as Administrator or as a user with administrative privileges.

2. Make a backup copy of C:\Artios\WebCenter\config\appconfig.xml. This ﬁle will be on
the C: drive no matter where you installed WebCenter.
3. Open the ﬁle named in the previous step in a text editor such as Notepad.
4. Scroll down to <store_files_in_blob value="false"/> and change false to true.
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5. Save the ﬁle and exit the text editor.

Restarting Services
Once you have changed appconfig.xml on the Application Server, restart all the Application
Server’s WebCenter services to start using BLOBs in ArtiosCAD Enterprise.
1. On the Application Server, still logged in as Administrator or as a member of the local
Administrators group, open the Services applet in the Administrative Tools group in Control Panel.
2. Restart the following services by clicking each one and then clicking the Restart link:
a) WebCenter JBOSS Application Server
b) WebCenter CAD-X
3. Close the Services applet and log off the Application server.
ArtiosCAD Enterprise is now conﬁgured to use BLOBs. Note that WebCenter will keep copies of
managed documents in its FileStore to improve performance.

10.3.2. Step 2 - Optionally Uploading Boards
In case the boards were not installed yet, follow this procedure after logging in to WebCenter for the
ﬁrst time:
1. Log in on the Web server as a member of the local Administrators group.
2. Run the setup program with WebCenter DVD.
3. Click Upload Boards.
4. In the Log In To Web Browser dialog box, enter the address of the WebCenter server, an admin
user's username, and that user's password. Click OK.
5. An Upload Boards progress bar will appear.
6. Click Close when the upload ﬁnishes.

10.3.3. Step 3 - Creating Shared Defaults for the First Time
The next step is to run the ArtiosCAD Defaults Manager installed when you installed ArtiosCAD
Enterprise on the Application server. The ﬁrst time you install ArtiosCAD Enterprise 16 or later, you
have to create the Shared Defaults. You can choose to either create completely new Shared Defaults,
or you can choose to migrate older Defaults that are merged with the defaults for the version you are
installing. In the future, you will add a new version's Defaults to the existing Shared Defaults Project.
You may also use this utility to migrate location and user defaults from older versions of ArtiosCAD
Enterprise to newer versions of ArtiosCAD Enterprise.
Note:
Even if you do not plan to use WebCenter in combination with ArtiosCAD Enterprise, it is still necessary
to install the Defaults in order for WebCenter to be able to process CAD ﬁles properly. Therefore, it is
highly recommended to install the Defaults, even if you do not plan to use CAD ﬁles initially.
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Note:
The system you use for loading the Defaults must be able to keep the Defaults on it. You will have
to follow the same process to load future Defaults and the new installation will reference the older
version’s Defaults as part of its installation. We recommend using the Application Server for this
process.
Note:
This procedure takes a signiﬁcant amount of time. We recommend starting it and doing other things
until it completes.
1. Log in to the Application Server as a member of the local Administrators group.
2. Click Start > All Programs > Esko > ArtiosCAD > Defaults Management to start the Defaults
Manager.
3. In the Login to Web Browser dialog box, enter your WebCenter server URL, admin username, admin
password, and click OK.
4. Click Create new shared defaults.
5. A progress bar appears. This step will take a few minutes.
6. Click Close when the installation process is done.

10.3.4. Conﬁguration in the WebCenter User Interface
Note: See the WebCenter Administration Guide for more details about the following steps.
1. Log on to WebCenter with the admin account (see Log On to WebCenter and Change the Admin
Password).
2. Conﬁgure a Company and Location for the initial ArtiosCAD Enterprise users.
3. Create a custom group, if desired, for the initial ArtiosCAD Enterprise users.
4. Create the initial ArtiosCAD Enterprise users. While creating them:
a) Make sure they are at least Project Managers with Limited Visibility of Companies and Groups.
b) Assign them to the Company and Location you created.
c) Assign them to one or more groups.
Even if you did not create any custom group, you should assign them to the USERS group.
5. Invite them to the System Defaults Project (which is Shared Defaults in ArtiosCAD Enterprise).
Tip: You can do this either individually for every user or once through Group membership if you
added all users to the same group (such as USERS).
Inviting them to the Project means that they will be able to use the Defaults.
In order for users to change Shared Defaults, they must have Full permissions on the Project and be
members of the ADMINS group.
Note: All ArtiosCAD Enterprise users must be invited to the System Defaults Project. Users who
are not invited to the project will receive a UFANEX error when they launch ArtiosCAD Enterprise.
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10.4. Secure your WebCenter Site with SSL
SSL is a protocol for securing communication over the Internet. It works by using a private key to
encrypt data that is transferred over an SSL connection.
URLs using an SSL connection start with https:// instead of http://.
To use SSL, you are required to obtain an SSL certiﬁcate and install it into Internet Information
Services (IIS) on the Web Server.
Note: We strongly recommend you secure your WebCenter site with SSL, especially if you plan to use
WebCenter over the internet (not only within a Local Area Network).

10.4.1. Secure the WebCenter Web Server with SSL
You will need to:
1. Create a Certiﬁcate Signing Request (CSR) on page 44.
2. Request an SSL Certiﬁcate from a Certiﬁcate Authority on page 45.
3. Install the Intermediate SSL Certiﬁcate on page 46.
4. Install your Signed Certiﬁcate on page 46.
5. Export your Certiﬁcate if Necessary on page 47.
You only need to do this if you haven't installed the certiﬁcates directly on your Web Server.
6. Bind your Certiﬁcate to your WebCenter Site on page 48.
7. Redirect HTTP Trac to HTTPS on page 48.

Create a Certiﬁcate Signing Request (CSR)
To get an SSL certiﬁcate, you need to ﬁrst create a Certiﬁcate Signing Request, that you will send to a
Certiﬁcate Authority.
1. On the Web Server, click Start, then Administrative Tools, then Internet Information Services (IIS)
Manager.
2. In the Internet Information Services (IIS) Manager dialog, click your server name (at left).
3. In the dialog's central pane, double-click the Server Certiﬁcates icon in the Security section.
4. In the Actions pane at right, click Create Certiﬁcate Request...
This opens the Request Certiﬁcate wizard.
5. In the Distinguished Name Properties screen, enter your information as follows:
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•

Common Name: the name through which the certiﬁcate will be accessed (usually the fullyqualiﬁed domain name, for example www.domain.com).

•

Organization: the legally registered name of your organization/company.

•

Organizational unit: the name of your department within the organization.

WebCenter
•

City/locality: the city in which your organization is located.

•

State/province: the state in which your organization is located.

•

Country/region: the two-lettered ISO-3166 country code of the country in which your
organization is located. You can ﬁnd a list of valid country codes on http://www.ssl.com/csrs/
country_codes.

Click Next.
6. In the Cryptographic Service Provider Properties screen:
•

leave Cryptographic Service Provider to Microsoft RSA SChannel Cryptographic Provider,

•

in Bit length, select 2048 or higher.

Click Next.
7. In the File Name screen, enter a name for your Certiﬁcate Signing Request, and select a location in
which to save it.
Click Finish.

Request an SSL Certiﬁcate from a Certiﬁcate Authority
The customer is responsible for choosing the SSL provider (Certiﬁcate Authority), obtaining
certiﬁcates, as well as following that company's speciﬁc instructions for installation and conﬁguration.
Esko cannot obtain SSL certiﬁcates on behalf of its customers.
1. Send your Certiﬁcate Signing Request ﬁle to a public Certiﬁcate Authority.
Note:
•

If you do an Internet Search for “SSL certiﬁcate”, you will ﬁnd many providers with different
pricing and options. We have good experiences with VeriSign, Network Solutions, Godaddy.com,
and Thawte.

•

The application process can take up to 30 days… Start the application process well in advance!

•

If your company has a DNB (Dun & Bradstreet) number, the application process will be a lot
easier and quicker if you can provide it.

•

Your certiﬁcate will be linked to your website (for example webcenter.domain.com).
Changing your website name will require a new certiﬁcate.

2. The Certiﬁcate Authority will provide you with:
•

an intermediate certiﬁcate, veriﬁed by the root certiﬁcate installed by default on your Web
Server (where you created the Certiﬁcate Signing Request),
Note: You may need to download this from a web link.

•

your server certiﬁcate, veriﬁed by that intermediate certiﬁcate (signed by the Certiﬁcate
Authority).
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Make sure you have both certiﬁcates before going further! You will need to install both of them on
your Web Server.
3. Copy those certiﬁcates to your Web Server.

Install the Intermediate SSL Certiﬁcate
You need to install the intermediate certiﬁcate before you install your signed certiﬁcate.
1. On your Web Server, click Start, then Run...
2. Type mmc and press Enter.

3. In the Microsoft Management Console (Console1) window that opens, go to File > Add/Remove
Snap-in...
4. In the Add or Remove Snap-ins dialog, select Certiﬁcates, and click Add.
5. In the Certiﬁcates snap-in dialog, select Computer Account, and click Next.
6. In the Select Computer screen, select Local Computer, then click Finish.
7. Click OK in the Add or Remove Snap-ins dialog.
8. In the Console1 window:
a) expand the Certiﬁcates (Local Computer) folder,
b) right-click Intermediate Certiﬁcation Authorities, and go to All Tasks > Import...
9. In the Certiﬁcate Import Wizard dialog:
a)
b)
c)
d)

click Next to get to the File to Import screen,
browse to the location containing your intermediate certiﬁcate ﬁle,
in the Open dialog, change the ﬁle extension ﬁlter to PKCS #7 Certiﬁcates (*.spc;*.p7b),
select your *_iis_intermediates.p7b ﬁle, and click Open.
Note: Only install your intermediate certiﬁcate, not your signed certiﬁcate in this area!
Installing your signed certiﬁcate here would remove your intermediate certiﬁcate from the list,
and you would need to reinstall it.

e) Click Next.
10. In the Certiﬁcate Store screen:
a) select Place all certiﬁcates in the following store,
b) click Browse, select Intermediate Certiﬁcation Authorities in the Select Certiﬁcate Store popup, and click OK,
c) click Next.
11. Click:
a) Finish in the Certiﬁcate Import Wizard dialog,
b) OK in the Certiﬁcate Import Wizard pop-up stating that the import was successful.
12. Close the Console1 window, then click No in the pop-up asking to save the console settings.

Install your Signed Certiﬁcate
Once your intermediate certiﬁcate is installed, install your signed certiﬁcate:
1. On the Web Server, extract your *.cer certiﬁcate ﬁle from the zip ﬁle you got from the Certiﬁcate
Authority.
2. Click Start, then Administrative Tools, then Internet Information Services (IIS) Manager.
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3. In the Internet Information Services (IIS) Manager dialog, click your server name (at left).
4. In the dialog's central pane, double-click the Server Certiﬁcates icon in the Security section.
5. In the Actions pane at right, click Complete Certiﬁcate Request...
This opens the Complete Certiﬁcate Request wizard.
6. In the Specify Certiﬁcate Authority Response screen:
a) browse to your *.cer certiﬁcate ﬁle,
b) enter a Friendly name for your certiﬁcate.
This will be used by the server administrator to easily distinguish the certiﬁcate.
c) Click OK.
Your certiﬁcate is now installed. If you cannot see it yet in the Server Certiﬁcates list of the Internet
Information Services (IIS) Manager dialog, press F5 to refresh.

Export your Certiﬁcate if Necessary
We recommend you create the Certiﬁcate Signing Request and install the certiﬁcates directly on your
WebCenter Web Server.
However, if you do this on another server, you can export the signed certiﬁcate then import it on your
Web Server.
1. If you haven't done so already, install the intermediate certiﬁcate on your Web Server.
2. Export your signed certiﬁcate from the server it is installed on:
a) In Internet Information Services (IIS) Manager, select your certiﬁcate in the Server Certiﬁcates
list and click Export... in the Actions pane at right.
b) In the Export Certiﬁcate dialog that opens:
1. Type a ﬁle name in Export to, or click the browse button to navigate to a ﬁle in which to store
the certiﬁcate for exporting.
2. Type a Password if you want to associate a password with the exported certiﬁcate.
3. Retype the password in Conﬁrm password and click OK.
This exports your certiﬁcate to a .pfx ﬁle.

3. Import your signed certiﬁcate on your Web Server:
a)
b)
c)
d)
e)

Click Start, then Administrative Tools, then Internet Information Services (IIS) Manager.
In the Internet Information Services (IIS) Manager dialog, click your server name (at left).
In the dialog's central pane, double-click the Server Certiﬁcates icon in the Security section.
In the Actions pane at right, click Import...
In the Import Certiﬁcate dialog that opens:
1. browse to your Certiﬁcate ﬁle (.pfx),
2. enter the Password associated with your certiﬁcate if there is one,
3. make sure that Allow this certiﬁcate to be exported is selected.
Note: This is important, as due to a bug in IIS, the site binding will not work if the certiﬁcate
is not exportable.
4. Click OK.

Your certiﬁcate is now installed on your Web Server. If you cannot see it yet in the Server Certiﬁcates
list of the Internet Information Services (IIS) Manager dialog, press F5 to refresh.
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Bind your Certiﬁcate to your WebCenter Site
Once you have installed your certiﬁcate on your Web Server, you need to bind it to your WebCenter site,
so that the certiﬁcate will be used to authenticate your WebCenter site when users browse to it.
1. Still in the Internet Information Services (IIS) Manager, right-click the Default Web Site node in the
Connections pane, (or the node of the IIS website you have deployed your Web Server on if it's not
the default website) and select Edit Bindings...
2. In the Site Bindings dialog that opens, click Add.
3. In the Add Site Binding pop-up:
a)
b)
c)
d)

Choose https as Type.
Leave the default https Port (443).
In the SSL Certiﬁcate list, select your Web Server.
Click OK and then OK again.

Redirect HTTP Trac to HTTPS
To ensure security, end users should only use https:// to access your WebCenter site. If someone
accidentally uses http:// instead, they will not be using a secure connection.
To avoid this, you can make sure http:// trac to your WebCenter site is automatically redirected to
https://. This will be transparent for the users (they will not get an error page but will simply be able
to access your site through https://).
For this, you need to download a (free) extension for IIS.
1. On your Web Server, download and install the URL Rewrite extension for IIS.
Go to http://www.iis.net/downloads/microsoft/url-rewrite, click the Install this extension button
and follow the steps on screen.
2. In the Internet Information Services (IIS) Manager, make sure SSL is not required so users don't get
an error when connecting to your site using http://:
a) Select the Default Web Site node in the Connections pane, (or the node of the IIS website you
have deployed your Web Server on if it's not the default website).
b) Double-click SSL Settings in the center pane.
c) Under SSL Settings, make sure that Require SSL is not selected.
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3. Click Default Web Site or the node of your IIS website again, then double-click URL Rewrite in the
center pane.
4. Create a blank inbound rule:
a) Click Add Rule(s)... in the Actions pane at right.
b) In the Add Rule(s) pop-up, click Blank rule under Inbound rules, then click OK.
The center pane now shows the Edit Inbound Rule form.
5. Edit the rule as follows to perform the automatic redirection:
a) Enter a Name for the rule, for example HTTP to HTTPS redirect.
b) Under Match URL, ﬁll in the settings as follows:
Requested URL

Matches the Pattern

Using

Regular Expressions

Pattern

(.*)

Ignore case

on

c) Under Conditions, select Match All in Logical grouping.
d) Add the ﬁrst condition:
1. Click the Add... button to open the Add Condition pop-up.
2. Fill in the settings as follows:
Condition input

{HTTPS}

Check if input string

Matches the Pattern

Pattern

off

Ignore case

on

This ignores addresses starting with https:// (they don't need to be redirected).
3. Click OK.
e) Add the second condition:
1. Click the Add... button to open the Add Condition pop-up.
2. Fill in the settings as follows:
Condition input

{SERVER_ADDR}

Check if input string

Does Not Match the Pattern

Pattern

::1

Ignore case

on

This ignores addresses using localhost through IPV6 (::1), as forcing https:// for those
would give a certiﬁcate error as the one below (because the certiﬁcate is linked to your site
name and not the server's IPV6 address).
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3. Click OK.
f) Add the third condition:
1. Click the Add... button to open the Add Condition pop-up.
2. Fill in the settings as follows:
Condition input

{SERVER_ADDR}

Check if input string

Does Not Match the Pattern

Pattern

127.0.0.1

Ignore case

on

This ignores addresses using localhost through IPV4 (127.0.0.1), as forcing https:// for
those would give a certiﬁcate error (because the certiﬁcate is linked to your site name and
not the server's IPV4 address).
3. Click OK.
g) Under Action, ﬁll in the settings as follows:
Action type

Redirect

Redirect URL

https://website-name.com/
{R:1}
where website-name.com is the
name of your WebCenter site, to which
you have linked your certiﬁcate

Append query string

on

Redirect type

Found (302)

Your rule should look like this:
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h) Click Apply in the Actions pane at right.
You should now see your rule in the URL Rewrite list in the center pane.
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6. Browse to your WebCenter site using http:// and check that it is redirected to a https://
connection.

10.4.2. Install SSL Certiﬁcates on the Workﬂow Production Server
If...
•

you are planning to integrate your Automation Engine server with WebCenter,

•

your WebCenter site is secure (it demands https:// connections),

•

your Automation Engine server and your WebCenter are not located within the same Local Area
Network,

... you need to make sure your Automation Engine server can communicate with your WebCenter
server over https://.
Important:
If you have installed your certiﬁcates properly on the Web Server (the intermediate certiﬁcate and the
signed server certiﬁcate), this should work without you having to do anything.
If you haven't, or you are still experiencing connection problems, you should import the WebCenter
certiﬁcates into the Automation Engine keystore.
This can also apply when WebCenter and Automation Engine are in the same LAN, if https://
communication is also enforced inside the LAN. Check with your network administrator if this is the
case.

Export the Certiﬁcates from the WebCenter Site
1. Log on to the Automation Engine server as a local administrator.
2. Open a web browser and navigate to the secured WebCenter site.
3. Examine the WebCenter site’s certiﬁcates.
How you do this depends on the web browser you use:
a) Click the lock icon at the end of the address bar and click View certiﬁcates in the pop-up.

b) In the Certiﬁcate dialog, click the Certiﬁcation Path tab.
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This tab displays the certiﬁcate hierarchy. Each top-level entry in the hierarchy represents a
certiﬁcate.

4. Export all the certiﬁcates (top-level entries) in the hierarchy:
a) Highlight the ﬁrst certiﬁcate in the hierarchy (for example, Thawte Server CA (SHA1)).
b) Click View Certiﬁcate.
c) Click the Details tab.

53

10

10

WebCenter

d) Click Copy to File to begin the Export Wizard. Click Next.
e) Select DER encoded binary… (.CER) and click Next.

f) Click Browse or type in a valid path and name the certiﬁcate (*.cer). We recommend using a
short path and name (such as c:\temp\vali.cer). Click Next.
g) Click Finish, then OK and once more OK.
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h) Repeat these steps until you have exported all the certiﬁcates. Close the web browser when you
are ﬁnished.

Import the Certiﬁcates into the Workﬂow Server Keystore
While still logged on to the Automation Engine server as a local administrator, import the certiﬁcate
ﬁles into the Automation Engine keystore:
1. Open a DOS command prompt.
2. Change to the Esko Automation Engine software directory which contains the keytool utility: c:
\esko\bg_prog_fastservercltnt_v210\jre\bin
For ESKO Software platform , this will typically be c:\esko\bg_prog_fastservercltnt_v210\jre\bin
3. Run the import utility for each certiﬁcate downloaded, in the proper order: keytool
–importcert –file <path>\*.cer –alias <aliasname> -keystore
<keystore_path>.
Your <keystore_path> is the path to bg_prog_fastserver_vxxx\jre\lib\security
\cacerts. For example: c:\esko\bg_prog_fastserver_v210\jre\lib\security
\cacerts.
You will be prompted for a password. The password is: changeit (case sensitive).

4. You might be asked to trust the certiﬁcate. Enter Y for Yes.

It is also possible that the tool tells you that this certiﬁcate is already installed. If so, that’s ok, go on
with the next certiﬁcate.
You should get a successful message like Certificate was added to keystore.

5. Repeat for each certiﬁcate to import in the hierarchy.

6. Reboot the Automation Engine computer to ensure that the changes take effect.
Example
You are running Automation Engine 21.11 and the Automation Engine server software is installed on
E:\Esko.
You have downloaded two certiﬁcates from the WebCenter site in the folder c:\temp:
valicert.cer and starfield.cer.
valicert.cer was ﬁrst in the hierarchy, so you would import this ﬁrst, then repeat for
starfield.cer.
You would proceed as follows:
1. Using a command prompt, go to e:\esko\bg_prog_fastserver_v140\jre\bin.
2. Type Keytool –importcert –file c:\temp\valicert.cer –alias valicert –
keystore e:\esko\bg_prog_fastserver_v210\jre\lib\security\cacerts
3. If asked for the password, type changeit.
4. If asked to trust the certiﬁcate, type Y.
5. Repeat the same command for the next certiﬁcate, startfield.cer.
6. Reboot the Automation Engine computer to ensure that the changes take effect.
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Import the Certiﬁcates into the Workﬂow Client Keystore
With a secured WebCenter site (requiring https://), you cannot check the connection between
Automation Engine and WebCenter with the Check Connection button in Conﬁgure.
To be able to do this, you need to install the Web Server certiﬁcates in the Automation Engine client
keystore too (even if the client is running on the same machine as the Automation Engine server).
Tip:
You should also do this if publishing fails because Automation Engine doesn't have the appropriate
certiﬁcates. Typically, this gives an error message like the one below:
javax.net.ssl.SSLHandshakeException: sun.security.validator.ValidatorException: PKIX path
building failed: sun.security.provider.certpath.SunCertPathBuilderException: unable to
find valid certification path to requested target

1. While logged on to the Automation Engine client machine as a local administrator, open a DOS
command prompt.
2. Change to the Esko Automation Engine software directory which contains the keytool utility:
\bg_prog_fastservercltnt_vxxx\jre\bin
For ESKO Software platform, this will typically be c:\esko
\bg_prog_fastservercltnt_v210\jre\bin
Note: For the client, make sure to use bg_prog_fastservercltnt and not
bg_prog_fastserver as for the server!
3. Run the import utility for each certiﬁcate downloaded, in the proper order: keytool
–importcert –file <path>\*.cer –alias <aliasname> -keystore
<keystore_path>.
Your <keystore_path> is the path to bg_prog_fastservercltnt_vxxx\jre\lib\security
\cacerts. For example: c:\esko\bg_prog_fastservercltnt_v210\jre\lib
\security\cacerts.
You will be prompted for a password. The password is: changeit (case sensitive).

4. You might be asked to trust the certiﬁcate. Enter Y for Yes.

It is also possible that the tool tells you that this certiﬁcate is already installed. If so, that’s ok, go on
with the next certiﬁcate.
You should get a successful message like Certificate was added to keystore.

5. Repeat for each certiﬁcate to import in the hierarchy.

6. Reboot the Automation Engine computer to ensure that the changes take effect.

10.5. Install Certiﬁcates for LDAPS on the Application Server
To connect your WebCenter installation to a secure LDAP server (LDAPS), you have to install a
certiﬁcate obtained from that LDAPS server.
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1. Open a command prompt on the WebCenter Application Server.
2. Change directory to the location of \WebCenter\ApplicationServer\LDAP
\CertInstall.bat.

3. Issue the following command: CertInstall servername:port, where servername is the name or IP of
the LDAP server and port is the port used for secure connection (typically 636).

4. To make changes active ensure that you restart JBoss, if JBoss was running.
If successful, a list of certiﬁcates sent by the server is displayed (ignore any additional messages).

5. To install a given certiﬁcate, enter its number in the list and press Enter.
We suggest that you install all certiﬁcates. Only one certiﬁcate can be installed each time you run
CertInstall so it can be necessary to run it multiple times.
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Note:
Troubleshooting the certiﬁcate installation
The certiﬁcates should be properly installed. If not, try these troubleshooting tips:
•

Server or port name is not correct
If the supplied parameters are wrong, the result can look something like the following:

In this case, contact your IT system administrator and verify the parameters supplied.
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10.6. Integrate WebCenter with a Workﬂow Production
Server
You can conﬁgure WebCenter to integrate with your existing Automation Engine production server.
In this documentation, we assume that you have both these applications installed and running properly.

10.6.1. Understanding WebCenter Integration
WebCenter can run without Automation Engine, but its full potential is realized when integrating both
systems.
Integrating WebCenter with an Automation Engine production server allows you to upload production
ﬁles to WebCenter for approval and advanced project management.
To make this collaboration between the systems possible, you must:
•

Add the WebCenter site information in the Automation Engine Conﬁgure window.

•

Conﬁgure the Job Web Page URLs in the Automation Engine Conﬁgure window.

•

Set up the WebCenter View information for the Automation Engine users.

•

Set up the Publish on WebCenter ticket.

Add the WebCenter Site Information
1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.
2. Choose Tools > Conﬁgure.
3. In the Conﬁgure window, select WebCenter Sites in the left pane.
4. Click the + icon.

5. In the Website ﬁeld of the Delivery area, enter the URL of the WebCenter site (for example:
http://wcrserver/WebCenter_Inst).
Note: If your site uses secure HTTP, make sure to enter an HTTPS address.
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6. Click Open... to test the connection. The login page for WebCenter should appear. If it doesn't,
check your settings.
7. If the Automation Engine server and the WebCenter Application Server are not on the same LAN,
deselect WebCenter and Automation Engine are in the same LAN.
If using Automation Engine 18.0.1, 18.0, or 16.1.1 to connect to WebCenter for outside-LAN approval
feedback, you need to install a hotﬁx on Automation Engine for this functionality to still work after
updating to WebCenter 18.1.
The hotﬁxes can be downloaded from mysoftware.esko.com:
•
•
•

Automation Engine 16.1.1: HF_201801047_20181212_AE-WCR_18_1
Automation Engine 18.0: HF_201806059_20181212_AE-WCR_18_1
Automation Engine 18.0.1: HF_201811018_20181212_AE-WCR_18_1

Older versions of Automation Engine are not ocially supported.
The User Name and Password ﬁelds then become available. This is where the Automation Engine
Approval Client conﬁguration in WebCenter is used.
Create a user name and password combination in WebCenter, then enter that same (case-sensitive)
user name and password in the appropriate ﬁelds in Automation Engine Conﬁgure.
Click Check Connection to test the connection.
Important: You must be using the Pilot on the Automation Engine server itself to run this check.
A dialog box appears, proving that the connection works and displaying the WebCenter version
number.
8. If the Connect to JDF Processor area is visible, leave JMF selected in it.
9. Click Check to test the connection.
An Info dialog appears, reporting that the connection is OK. Click OK.
If this dialog does not appear, check your settings.
10. On the left of the Conﬁgure window, scroll down and select the new WebCenter1 entry under
WebCenter Sites.
11. Click File > Rename and enter a descriptive name for your WebCenter site.
12. Click File > Save to save the settings.

Conﬁgure the Job Web Page URLs
The Job Web Page enables you to go to your WebCenter project from within your Automation Engine
Job.
1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.
2. Choose Tools > Conﬁgure.
3. In the Conﬁgure window, select Jobs > Job Web Page in the left pane.
4. In the Address ﬁeld, enter the URL of the WebCenter site (for example: http://pacwebserver/
WebCenter).
5. Still in the Address ﬁeld, append this text to the end of the URL: /projdetails.jsp?
projectName=
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Attention: This is case-sensitive; enter it exactly as written. Do not include a space or
period at the end.
6. Click +[ ] InsertSmartNames.
7. In the SmartNames column, scroll down and click JobName.
8. Click Insert to append it to the URL in the Address ﬁeld.
9. Click Close to return to the Conﬁgure window.
The result should resemble http://pacwebserver/WebCenter/projdetails.jsp?
projectName=[JobName] with [JobName] in green.

10. Click File > Save to save the settings.

You can now right-click your Job folder in the Automation Engine Pilot and select Go to Job Web Page;
this opens the WebCenter project associated with your Job in a browser.

Set Up the Publish on WebCenter Ticket
The Publish on WebCenter ticket in Automation Engine creates output and uploads the resulting ﬁles
to WebCenter.
For more details, please see the Automation Engine documentation.
1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.
2. Click the Tickets view.
3. Locate the Publish on WebCenter default ticket, right-click it and click Duplicate....
4. In the Save As pop-up that opens, replace the word Default in the Save As ﬁeld with a meaningful
name (for example the name of your WebCenter site).
5. In the Scope area, select the Global option.
If you have no blue job folders containing ﬁles, you are not prompted to select the scope.
6. Click Save. The new ticket should appear in the list.
7. Double-click your new Publish on WebCenter ticket to change its settings.
8. On the Destination tab, deﬁne where you want to publish your ﬁle:
a) In the Site list, select your desired WebCenter site.
b) In the Project ﬁeld, enter the JobName SmartName so that the ﬁles are published to the
WebCenter project corresponding to your Automation Engine job.
Note:
•

The project does not have to exist in WebCenter at upload time. If the project does not exist,
it will be created. In this case, the person that does the upload from Automation Engine
needs to be Project Manager in WebCenter! Otherwise the upload will fail.

•

If your main goal is not to upload ﬁles but to create WebCenter Projects through Automation
Engine, we recommend you use the Create or Modify WebCenter Project ticket instead (see
the Automation Engine documentation for more information).

c) Leave the Folder and Project Template ﬁelds blank unless you know the exact names of the
folder and project template you want to use for every new Project.
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In this case, enter them as appropriate; all new WebCenter Projects created with this ticket will
use these values.
Note:
•

The Project Template ﬁeld refers to a template in WebCenter, not Automation Engine.

•

You can only use templates that are visible by the WebCenter user performing the upload
(see sub-step f).

d) Enter a Document Name if you want your published document to have a name different from the
input ﬁle name.
Note: If the document already exists, the task will create a new version of that document. If it
exists but is in a different folder, the task will fail.
e) Enter a Document Description if desired; this description will be available in WebCenter as a
Version Comment.
f) Leave the User Name and Password ﬁelds blank unless there is a speciﬁc (and valid!)
WebCenter user who will own each document revision published using this ticket; in that case,
enter the appropriate information.
If you leave these ﬁelds blank, anyone using the ticket will have to supply a valid user name and
password each time it is used.
9. On the Publish tab:
a) Leave Prepare for viewing and annotating and Make available for download selected.
b) In the Allow Downloading in WebCenter area, choose the kind of ﬁles to upload to WebCenter.
•

Input ﬁles are the original ﬁles themselves.

•

PDF ﬁles for prooﬁng are proxy ﬁles created by using the selected ticket. If you choose
PDF ﬁles for prooﬁng, leave the default Create SoftProof for WebCenter ticket selected, or
choose another ticket if desired. Proxy ﬁles uploaded in this manner will have Download PDF
for printing as an option in WebCenter.

The combination of preparing for viewing but not making available for download is intended for
Graphics ﬁles that only need Approval.
10. On the Approval tab, deselect Start the Approval Cycle.
11. Click Save. Then click Yes to conﬁrm overwriting the ticket.

10.7. Expose WebCenter to the Internet
Exposing WebCenter to the Internet is the responsibility of your local IT department. Esko cannot do
this for you.

10.7.1. Register a Domain Name
Register and pay for a domain name, such as www.esko.com, to allow internet users to navigate to
your WebCenter site.
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Once you have registered the domain name, your company is the only one authorized to use that
speciﬁc domain name for a certain period.
•

Contact a proper authority (VeriSign, GoDaddy, etc) and purchase a domain name.

10.7.2. Contact Your ISP to Set Up an A Record
The purpose of an A record is to associate your domain name to your public ﬁrewall/router, so web
trac (HTTP and HTTPS) going to the domain name is routed to that public ﬁrewall/router.
Think of this as telling the Postman how to get to your mailbox.
Note: It takes several days for the A record information to propagate around the world.
1. Identify the public IP Address of your router/ﬁrewall.
This is the hardware appliance your Internet connection is plugged into (i.e. T1, DSL).
For example: My T1 is plugged into a ﬁrewall with 66.55.44.33 as public IP address.
2. Contact your ISP and ask them to add an ‘A’ Record (Address record) to the global DNS (Domain
Name Servers), associating your domain name and your router/ﬁrewall public IP address.
3. Verify that you can ping your domain name from computers inside and outside your LAN.
4. Ensure the reply you get contains the correct IP address for your public ﬁrewall/router.
Example
MCI is your ISP. You contact MCI and ask them to add an A record for your new domain name,
www.esko.com, to forward HTTP and HTTPS trac to your public ﬁrewall IP address of 66.55.44.33.
After about 3 days or so, this record has been propagated across the world. If someone in Thailand
‘pings’ the domain name www.esko.com, he/she should receive a reply with the IP address of
66.55.44.33.

10.7.3. Move the Web Server Inside the Demilitarized Zone (DMZ)
You should physically arrange the network devices so that the Web Server is in a proper DMZ
architecture (between two ﬁrewalls or plugged into a DMZ port of the public router/ﬁrewall).
1. Conﬁgure Firewall 1 (public router/ﬁrewall):
a) Allowed to route trac to Web Server inside DMZ for HTTP and HTTPS.
b) Default ports 80 (HTTP) and 443 (HTTPS).
2. Conﬁgure Firewall 2 (gatekeeper for private network):
a) Allowed to route trac on speciﬁc ports to WebCenter’s Application Server.
b) Default ports 1099, 2500, 4444.
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Note: You can change the default port numbers used at any time—to do this, modify the IIS settings
and the WebCenter conﬁguration ﬁles on both the Web Server and the Application Server to reﬂect
these custom port numbers.

10.7.4. Conﬁgure IIS to Receive Trac
Web trac is delivered to the public ﬁrewall because of the A record. That ﬁrewall then forwards the
web trac to the Web Server inside the DMZ.
The Web Server application (IIS) needs to be conﬁgured to pick up this trac for processing. To do
this, the Web Server must be assigned a static Private IP Address.
1. On the Web Server, click Start > Run and type inetmgr. Then click OK to start Internet Information
Services (IIS) Manager.
2. Expand the Web Site node.
3. Right-click the Web Site node and choose Properties.
4. Click the Web Site tab and verify that the IP Address is correct (or use the drop down list to change
it).
5. In the TCP Port ﬁeld, ensure you are using the correct port for HTTP trac; the default port is 80
(this needs to match your ﬁrewall rules).
6. Close IIS Manager.

64

WebCenter

11. Deploying WebCenter
WebCenter uses a three-tier installation framework to facilitate in-house development and
conﬁguration before deploying it in production form. The three tiers are the Installation version, the
Development version, and the Production version.

Deployment Workﬂow
The intended workﬂow is to install WebCenter, deploy it to Development, modify the Development
version, and then when you are satisﬁed, deploy the Development version to Production.
As time goes by, you can keep modifying the Development version as desired without affecting the
Production version. When you are satisﬁed with the changes made to the Development version, you
can deploy it to Production.
At the time of deployment, the custom directory is not overwritten if it already exists in a target
instance, so customizationConfig.xml and any other customized ﬁles in the custom directory
are not changed. But when a new instance is created by deployment, the custom directory is created
with its default conﬁguration.

The WebCenter Deployment Manager
The WebCenter Deployment Manager, located in Start > Programs > WebCenter, manages the
deployment process. If there is more than one website on the Web Server, choose the website with
which the WebCenter Deployment Manager will work and click OK.

To further develop the installed version, use the WebCenter Deployment Manager:
•

If you want to change the name of the development version, click the ... button in the Development
area, and specify the new name of the development version. When you have changed the name,
click Deploy Development.
Web authors can then modify the site at http://WebServer_name/WebCenter_Dev (or
whatever name you chose earlier), while normal users can still work using the site at http://
WebServer_name/WebCenter_Inst.

•

Once the developed version is ready for production use, use the WebCenter Deployment Manager
again.
If you want to change the name and location of the production version, click the ... button in the
Production area and enter the new name. Then, click Deploy Production.
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The site in WebCenter_Dev will be copied to WebCenter. Production use starts by users pointing
their browsers to http://WebServer_name/WebCenter.
Note:
You can have multiple development and deployment versions of WebCenter by changing the names for
each deployment, e.g. DEV1, DEV_Other, WebCenter_Prod1, and so forth.
Also, the deployment name is not case sensitive, so for example WebCenter_Dev and WebCenter_dev
are considered to be the same deployment instances.
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12. Localizing WebCenter
Localization is the process of making a program ready to run anywhere in the world.
It encompasses modifying the display language, the way units are displayed, decimal separators, time
and date formats, and currency format to match the local user preferences.

12.1. Understanding Localization in WebCenter
WebCenter uses references to separate language ﬁles (text strings ﬁles) instead of using hard-coded
words. WebCenter ships with a variety of language ﬁles. Additionally, the text strings ﬁles can be
translated into any language.
Each WebCenter user can change to a different language in My WebCenter > My Preferences.
The default language can be changed in General Preferences at any time by any WebCenter user who is
a member of the Admins group.

12.2. How to Install Custom Translations
The language ﬁles are in the languages subdirectory of the WebCenter installation on the Web
Server, such as \Artios\WebCenter\WebServer\tomcat\webapps\<site name>
\languages.
They are named wcstrings_xx.xml where xx is a two-letter code for the language, for example en
for English, fr for French, and de for German.
1. Copy one of the existing language ﬁles, and rename the copy changing the two-letter language
code to the new language code.
Note: The language code must match the ocial list of two-letter ISO 639-1 codes at http://
www.loc.gov/standards/iso639-2/englangn.html. For example, a Danish language word
strings ﬁle would be named wcstrings_da.xml.
2. Translate the strings in the ﬁle.
3. On the Web Server, open \Artios\WebCenter\WebServer\tomcat\webapps
\WebCenter_instance\config\config.xml in a text editor or an XML editor. In the
Languages section of the ﬁle, add a key for the new language, for example <Language key=”da”/>
for a Danish translation.
4. Put the translated language ﬁle in the languages subdirectory of the WebCenter installation.
5. Open every other wcstrings_xx.xml ﬁle and add a <NLanguage_xx>Language</
NLanguage_xx> string after the strings for the existing languages.
For example, add the string <NLanguage_da>Danish</NLanguage_da> to install a Danish strings
ﬁle, substituting the word for Danish in the appropriate language for the string ﬁle.
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6. If the chosen language is a multi-byte language (such as Japanese, Chinese, or Thai), log on to the
Application Server and edit \Artios\WebCenter\config\appconfig.xml. Change the value
in the index_lang ﬁeld to the appropriate language code that is listed in the comment below the
ﬁeld, and save the ﬁle.
7. Restart the Web Server to see the changes.
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13. The Help System
Old style dynamic help system
WebCenter uses a dynamic help system that checks for the existence of speciﬁcally-named
XSL ﬁles on the Web Server in \Artios\WebCenter\WebServer\tomcat\webapps\
<WebCenter_instance>\help.
A Help link will appear in the menu of the page that has the same name as an XSL ﬁle in this directory.
The content of a Help ﬁle can be anything provided it is in XSL and the ﬁle has an .XSL extension.
Note: Esko recommends the use of xmlspy® for authoring WebCenter Help XSL ﬁles. It is available
from http://www.xmlspy.com. There are also shareware and freeware XSL editors available. You could
also modify the sample provided using a text editor such as Notepad; do not use WordPad as it inserts
its own formatting codes.
•
•

To change the Webmaster contact name and e-mail address displayed on the login help page, edit
login.xsl.
If using foreign-language ﬁles, append _xx (where xx is the code for the language) to the end of the
ﬁle name before the extension, such as login_fr.xsl for a French help ﬁle for the login page.

When determining if a Help link should be on a page, WebCenter looks for a localized Help ﬁle, and then
for an English one if a localized one is not found. If neither exist, WebCenter does not put a Help link on
the page.
New style dynamic help system linked to help.esko.com
Since WebCenter 12.1, a lot of pages (mostly in the admin section) use a dynamic help system linked
to help.esko.com. When a user clicks the help icon, context-aware help information is displayed. By
default the documentation from help.esko.com is shown, but this behavior is customizable.
It is possible to customize a speciﬁc help topic, or to link a subset of help topics to a speciﬁc manual or
page. The behavior of the help functionality can be conﬁgured in the custom folder on the Web Server.
Each help link has a topic (i.e. common/wc/reference/re_task ). The topic of a help link can be found by
looking at the link address: a help icon always links to help.jsp?topic={TOPIC}&lang={LANG}.
For customization, the following options are available:
•

•

By placing html ﬁles in the correct location in the custom folder on the Web Server: Customization
for help pages is done in the custom/help directory. Customization can be done per language (by
adding ﬁles to custom/help/{LANG} directory (where {LANG} is the abbreviation for the language in
WebCenter i.e. custom/help/en for English). Customization can also be done for all languages. This
is done by putting ﬁles in custom/help/all.
By adding a helpconﬁg.xml ﬁle with speciﬁc settings to the custom/help folder on the Web Server:
This ﬁle can contain a set of rules that will be applied when no speciﬁc custom topic is found. In the
custom help ﬁle you deﬁne rules that match topic names. When a rule matches, the rule is applied
by sending the user to the correct location, deﬁned in the rule.
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Note:
The system ﬁrst searches in the language speciﬁc custom folder for a customized html ﬁle, if no html
ﬁle is found for a speciﬁc language, it will search in the custom/help/all folder for that topic.
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14. Upgrading WebCenter
You can upgrade directly to WebCenter 21.11 from older versions.
If you have an older version than 12.0, you will need to ﬁrst upgrade to WebCenter 10.1 or 10.2, make
sure it is running correctly, then upgrade to WebCenter 21.11.

14.1. Forced System Reboot during Upgrade
When updating WebCenter, a full re-installation is required. You need to remove the existing
installation before installing a new version.
After uninstalling, you have to reboot to be able to proceed with a new Installation process. This is
enforced before installing another version.
Note: Reboot pending state of a system can be activated not only by WebCenter but also by completed
Windows updates or other application installation operations.

14.2. Conﬁguration Retained During Upgrade
14.2.1. Retained Conﬁguration Values during Upgrade
WebCenter Installer will store speciﬁc conﬁguration values of the existing installation when it is being
uninstalled. These conﬁguration values will be used during the upgrade.
The Installer input ﬁelds will use these stored values for the new installation. You only have to verify if
this pre-populated data during the installation process.
The following values are stored by the system:
•

Web Server
•

•

Application Server Hostname

Application Server
•
•
•
•
•
•

Web Server Hostname
Database Server Hostname
Database type (MS SQL or Oracle)
Database Instance name (MS SQL only, default instance can be used in which case this setting is
empty)
Database connection SID (Oracle only)
SA database User password (default password)
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Note:
1. The password value is not retained, if a custom password was used during the previous
installation. You will have to type in this password in this ﬁeld.
2. Settings made for weekend days other than Saturday and Sunday, has to be made again in
Application server. Refer to the steps here.
•

FileStore folder path(s) (UNC path is allowed)
Note: As this mechanism includes persistence of custom FileStore path values, the
appconfig.xml conﬁguration ﬁle does not have to be modiﬁed after re-installing a new
WebCenter version.

•

Installation Choice: Simple or Advanced
•

If Advanced Installation is selected, the following choices are retained:
•
•
•

Java Heap Space Size: Normal or Extra Large
View Server: Internal or External
Database (internal) User password: Default or Custom
Note: The password ﬁeld is always left empty.

14.2.2. FileStore Split during Upgrade
To prevent FileStore size problems, WebCenter supports FileStore split into separate folders. The
conﬁguration of the different FileStore paths is stored within appconfig.xml.
During the uninstallation phase, the application reads the appconfig.xml ﬁle and stores all the
custom settings. When you re-install, the Installer updates the appconfig.xml with these custom
values instead of default values (derived from the default FileStore location).
Following FileStore paths can be customized in appconfig.xml and the custom values are kept
during the reinstall process:
•

temp_dir- This node mentions the folder used to keep temporary work ﬁles.

•

viewer_data_dir- The node mentions the folder used to store 2D Viewer data ﬁles for individual
viewable WebCenter Documents.

•

document_thumbnails_dir- The node to store thumbnail ﬁles for Documents that support having
custom thumbnails generated per Document WebCenter object.
This is optional. If it is missing, Document Thumbnails are stored in the same folder as the main
Document ﬁles (as set in document_dir node).

•

document_perspectives_dir- The node to store various default and custom Document Perspective
ﬁles for individual Documents (set of supported Perspective types varies based on the Document
Type).
This is also an optional folder. If it is missing, Document Perspectives are stored in the same folder
as the main Document ﬁles (as set in document_dir node).
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15. Prepare for the Upgrade
This describes how to upgrade from older versions of WebCenter to the latest build of WebCenter
21.11.
Note:
This procedure applies to all upgrade installations of WebCenter 21.11, even to "minor" updates
between builds of the same version.
Note:
This procedure is fairly complex and involves direct manipulation of core application and database
ﬁles.
Expert help is available to perform the upgrade for you at a minimal cost: contact your local Esko
Customer Services division for a quote and scheduling.

15.1. Prerequisites for the Upgrade
Installation Media and Licenses
Make sure you have the following at hand before proceeding:
Media
•

WebCenter 21.11 DVD

•

Automation Engine 21.11 DVD

Licenses
•

ArtiosCAD (21.07 FlexNet server license)

•

WebCenter 21.11 (plus optionally Task Management, Advanced Approval, PDF download, Reporting,
extra concurrent users)

•

OBGE (On Board Graphics Engine)

Information Needed
Make sure you collect the following information:
•
•

The location of the FileStore (you can ﬁnd this information in C:\Artios\WebCenter\Config
\appconfig.xml)

The database engine to use (SQL Server 2012(Express Edition) /2014(Express Edition)/2016 (Express
Edition), 2017( Express Edition), 2019 (Express Edition) Oracle 10g or Oracle 11g or Oracle 12c).

•

The name of the Database Server, the Oracle Database Identiﬁer (SID) if using an Oracle database,
and the database administrator password (sys password).

•

The name and location of the WebCenter4_0 database instance (you can ﬁnd this information in
<DRIVE>:\Esko\Artios\WebCenter\ApplicationServer\Jboss\server\default\conﬁguration
\standalone.xml. Use your Esko customer login and password for activating licenses.
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•

The IP address or name of the LDAP server and the port used for the secure connection (typically
636).

If you are upgrading from 16.1.1 or 18.0 to 18.0.1 or 18.1.1 to 20.0
WebCenter Installer will store speciﬁc conﬁguration values of the existing installation when it is being
uninstalled. These conﬁguration values will be used during the upgrade.
The Installer input ﬁelds will use these stored values for the new installation. You only have to verify if
this pre-populated data during the installation process.
The following values are stored by the system:
•

Web Server
•

•

Application Server Hostname

Application Server
•
•
•
•
•
•

Web Server Hostname
Database Server Hostname
Database type (MS SQL or Oracle)
Database Instance name (MS SQL only, default instance can be used in which case this setting is
empty)
Database connection SID (Oracle only)
SA database User password (default password)
Note:
1. The password value is not retained, if a custom password was used during the previous
installation. You will have to type in this password in this ﬁeld.
2. Settings made for weekend days other than Saturday and Sunday, has to be made again in
Application server. Refer to the steps here.

•

FileStore folder path(s) (UNC path is allowed)
Note: As this mechanism includes persistence of custom FileStore path values, the
appconfig.xml conﬁguration ﬁle does not have to be modiﬁed after re-installing a new
WebCenter version.

•

Installation Choice: Simple or Advanced
•

If Advanced Installation is selected, the following choices are retained:
•
•
•

Java Heap Space Size: Normal or Extra Large
View Server: Internal or External
Database (internal) User password: Default or Custom
Note: The password ﬁeld is always left empty.

15.2. Prepare for the Upgrade on the Application Server
1. Copy the following onto the Application Server:
•
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•

Automation Engine 21.11 DVD

•

ArtiosCAD en license

•

WebCenter 21.11 license (plus optional module licenses)

•

OBGE (On Board Graphics Engine) license

2. Back up:
•
•
•

the FileStore
the WebCenter4_0 database
the \Artios\WebCenter folder

•

the \Esko\Artios\WebCenter folder

•

any E-mail Notiﬁcation customizations that may be stored in \WebCenter
\ApplicationServer\EmailNotifications\Custom

•

any Auto Translation Service customizations that may be stored in \WebCenter
\ApplicationServer\wildfly\modules\com\esko\webcenter\translator
\main\translator-service-1.0.jar

•

all other non-standard customizations you may have implemented outside of the custom
folders

3. Make a restore point for the OBGE.
4. Make a backup of the server software conﬁguration.
For detailed instructions on step 3 and 4, please refer to the Automation Engine 21.03 Installation
Manual.

15.3. Prepare for the Upgrade on the Web Server
1. Copy the following onto the Web Server:
•

WebCenter 21.11 DVD

2. Back up \Artios\WebCenter and any non-standard customizations you have implemented
outside of the WebCenter instances.
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16. Upgrade WebCenter
16.1. Remove WebCenter
1. On the Application Server:
a) Remove the WebCenter software using the Add/Remove Programs applet in the Control Panel.
b) Reboot the server.
c) Using Windows Explorer, remove the \Artios\WebCenter and \Esko\Artios\WebCenter
folders, and any other remaining WebCenter-related folders.
Note: Take care not to remove the FileStore if it is inside a WebCenter folder!
2. On the Web Server:
a) Remove the WebCenter software using the Add/Remove Programs applet in the Control Panel.
b) Reboot the Web Server.
c) Using IIS, remove all WebCenter instances (only the default "WebCenter_Inst" is removed
automatically).
d) Using Windows Explorer, remove \Artios\WebCenter, and any other remaining WebCenterrelated folders.

16.2. Install WebCenter
1. On the Application Server, update the older version of ArtiosCAD Enterprise to the latest version
of ArtiosCAD Enterprise, choosing the options described in Install ArtiosCAD Enterprise on the
Application Server on page 24 and the Use the default conﬁguration upgrade option.
2. Upgrade the license component using the Automation Engine 21.11 DVD:
a) Insert the Automation Engine 21.11 DVD.
If the DVD does not auto-start, double-click setup.exe in its root folder.
b) In the window that opens, click English.
c) Click either:
•

Software Installation in the main menu on the left of the window,

• Proceed to the installation >> at the bottom of the window.
d) Click Install on the next page.
e) On the Instructions page, click Run the Automation Engine System Readiness Check.
At the end of the Readiness Check, read the resulting messages carefully. If the Readiness
Check resulted in a problem, correct it before proceeding. Click Exit in the Automation Engine
System Readiness Check dialog when this is done.
f) Click Install the License Server Components.
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g) Click Install the System Controller 1.0 and follow the instructions of the installation wizard.
3. Activate the Licenses on page 25.
4. Uninstall the old version of ArtiosCAD Enterprise.
5. Install WebCenter 21.11, using the English language installer, on the Application Server and on the
Web Server, making use of the existing FileStore location and WebCenter4_0 database location.
Note: The installers in other languages should not be used, until further notice.
See Installing WebCenter on page 22 for more information on the installation procedure.
6. Install Certiﬁcates for LDAPS on the Application Server on page 56.
7. When the upgrade installation is completed, the search crawler needs to be updated. This is to
ensure that the search results are up to date or else may result in incomplete search results. To
rebuild Search Crawler, Go to Conﬁguration > Search Crawler Set up and click on Rebuild Index.
This operation can take several hours depending on the number of projects, tasks, document
(versions) present. Rebuilding the search index has a serious performance impact, and it is advised
to run this over the weekend. Search results will be incomplete as long as the index is being rebuild.
This is to ensure that the search results are upto date and complete.

16.3. Upgrade the OBGE
Note:
•
•

The OBGE must have the same or a later version than the Automation Engine production server.
Make sure that you do not update any CADx component while updating the OBGE! CADx must only
be updated by the ArtiosCAD Enterprise installer.

Upgrade the OBGE (On-Board Graphic Engine) to Automation Engine 21.11 :
1. Upgrade the prerequisite components:
a) Insert the Automation Engine 21.11 DVD.
If the DVD does not auto-start, double-click setup.exe in its root folder.
b) In the window that opens, click English.
c) Click either:
•

Software Installation in the main menu on the left of the window,

• Proceed to the installation >> at the bottom of the window.
d) Click Install on the next page.
e) Click Install the prerequisite components and follow the instructions of the installation wizard.
Note: Remember to not update any CADx component!
The prerequisite components are now upgraded.
2. Test the OBGE and check its conﬁguration (Hot Folder and container, see Conﬁgure the OBGE on
page 38 for details).
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16.4. Conﬁgure WebCenter
1. If you had WebCenter customizations:
a) Reapply the email notiﬁcation customization that you backed up in your custom folder.

Mentions of an older version of WebCenter are automatically updated to "WebCenter 14".
b) Apply any standard customizations you saved earlier to your new WebCenter instance(s).
c) Redo any other non-standard customization that you may have had.
See the WebCenter Customization guide for more information.
Attention:
•
•

Do NOT copy the ﬁles as the XML structure might be different and you might break it.
Do not customize the Default instance of WebCenter as if it doesn't work anymore
you will have to completely reinstall it!

2. In case running the database scripts automatically (preferred) is switched off, run the WebCenter 14
database scripts.
See Run the Database Schema Scripts on the Application Server on page 29 for more information on
the database schema scripts.
3. Log on the WebCenter web interface and change the administrator password (see Log On to
WebCenter and Change the Admin Password).
4. Deploy new WebCenter instances as desired.
See Deploying WebCenter on page 65 for more information.
The upgrade is complete.

16.5. Additional step when you upgrade from 18 to later
versions
When performing an upgrade to installation of a WebCenter 18.0 or later, if the Web server is on the
same host as the installer, then the following options are available if the custom folders is backed up:
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•

Redeploy web instances with customizations: This is the default option. Re-deploys the custom
instances marked during the previous uninstall procedure as well as the custom folders backup.

•

Redeploy web instances without customizations: Re-deploys the custom instances marked during
the previous uninstall procedure but will not retain the backed-up custom folders.

•

Do not redeploy automatically: Will not re-deploy any of the custom instances and their custom
folder backups.
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17. Uninstalling WebCenter
1. Log on to the Web Server as a member of the local Administrators group.
2. Stop the IIS Admin service.
3. Backup all deployed sites within \Artios\WebCenter\WebServer\Tomcat\webapps in case
they are needed in the future.
4. In WebCenter 18.0 or later, Web server installer records the names of all the custom WebCenter
instances while backing up the custom folder where all Web server based customizations of a given
instance including the default WebCenter_Inst are stored.
Common App Data root folder is used to store the customization ﬁles backup on the target Web
server host. The default path on most Windows server would be C:\ProgramData\Esko\WebCenter
\WebInstanceCustomData.
This folder is the root and each WebCenter web instance custom folder ﬁles that was backed up is
stored under a subfolder that takes the name of the appropriate instance.
The list of web instances that were found and can be later re-deployed are stored in the registry
among the other WebCenter upgrade values. Read more about this here Additional step when you
upgrade from 18 to later versions on page 78.
5. Use the Add/Remove Programs applet in Control Panel to remove WebCenter.
6. Manually delete all subdirectories under \Artios\WebCenter.

7. Log on to the Application Server as a member of the local Administrators group.
8. Back up \Artios\WebCenter\Filestore and all its subdirectories in case they are needed in
the future.
9. Use the Add/Remove Programs applet in Control Panel to remove WebCenter.
10. Manually delete all subdirectories under \Artios\WebCenter
for the Automation Engine Prerequisites

If WebCenter is uninstalled with the intention of installing a newer version (and keeping an existing
database), do NOT delete the ﬁles in \Artios\WebCenter as they contain information needed
for the new version to run with the existing admin password.
11. If using Microsoft SQL Server 2008, or Microsoft SQL Server 2008 Express Edition, back up the
WebCenter4_0 database and then use Enterprise Manager to manually delete the WebCenter4_0
database.
If using Oracle, backup the database and either delete the instance, or, if it is shared, connect to the
instance and issue the drop user webcenter cascade; command.
12. If the OBGE is installed, remove all the Esko products using the Add/Remove Programs applet in
Control Panel. Select all products except the FLEXlm ﬂexid drivers.
13. Remove ArtiosCAD Enterprise by using the Add/Remove Programs applet in Control Panel. Once all
the products are removed, WebCenter should be completely removed.
14. Reboot your machine. If you need to install another version, this is a required step.
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